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Documents
JavaScript samples for everything 
except forms, security, or 
collaboration.


Forms
JavaScript samples to help 


create and manage Acrobat 
forms.
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JavaScript for Forms
Date handling


Date timestamp: first time only     8
Gets today’s date as a one-time timestamp so it won’t be updated 
each time the page is opened.


Date Parsing     8
Formats the current date using AFParseDateEx().


Displaying a localized date     8
Uses the util.printd method to display a localized date, including 
for CJK language documents. [Acrobat 7 or higher]


Getting today’s date     9
Get today’s date and display it.


Calculations
Calculations: Turn calculations on/off     9
Turn off calculations to optimize performance.


Delay redrawing of appearance changes     9
Delays redrawing of all fields until all changes are completed.


Field Operations
Add/Remove a new field programmatically     10
Places a new form field on the specified page.


Add/Remove fields on multiple pages     10
Create or remove identical text fields on every page of a 
document.


Changing field properties     11
Change any or all of the properties of a form field.


Color: defining a custom color     12
Define a custom RGB color for use, for example, as a form field 
background color.


Check a check box field     12
Inspect whether a check box field has been checked.


Formatting a number in a form field     12
Shows how to format numbers in decimal, hex, and floating 
formats as well as formatting the value as a string.


Formatting: removing zeros so field is blank     13
Removes zeros (0.00) in auto-calculated fields.


Hiding/un-hiding an existing field based on conditions     13
Hide or expose a field based on the state of a check box field.


Highlighting a single field     13
Highlight a single field for the On Focus event, and turn off the 
highlighting for the On Blur event.


Highlight fields using a function     14
Create a function to highlight a field, to be called from multiple 
fields.


Highlighting multiple fields using a for loop     14
Defines a Document Level JavaScript function that will highlight 
any field that calls the function when the mouse cursor enters that 
field. Code can be added to all fields by running a script from the 
JavaScript console.


Locating fields and listing field names     15
List all form fields including their name, type, and page number.


Printing: Set field to print or not print     16
Code to control the print property of a field so the field will either 
print or not print.


Print selected form pages     16
Print a selected range of form pages (for example, to exclude the 
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instruction pages in a form document).


Rollover help
Display help text     16
Display help text for a field for the Mouse Enter event.


Search fields
Search for all fields with a specified prefix     17
Search/enumerate through all fields that begin with specified 
string.


Set an action for a single field     17
Attaches an action to a single field.


Set an action for multiple fields     18
Execute code from the JavaScript console to attach an action to 
multiple fields.


Form checking and resetting
Final field checks


Check fields before submitting     18
Check that all required fields were completed before the form is 
submitted.


Resetting a form     19
Resets all fields, or specified fields, to their original default value.


Validation
Validate that number is in the correct range     20
Verify that entered value is in one of two ranges.


Verify that required entry was made     20
Check required fields for a valid entry.


Convert user input to uppercase characters     21
Converts lowercase characters typed by the user into uppercase 
characters.


Restricting keystrokes to uppercase characters     21
Restrict keystrokes to Y (for Yes) or N (for No) .
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JavaScript for Documents
Annotations


Add/remove annotations


Create an annotation       22
Illustrates how to create an annotation of type “Text”.


Remove an annotation       22
Removes an annotation.


Application Version
Version checking       22
Checks the version and type of the Acrobat application, and lists all 
plug-ins.


Bookmarks
Create a new bookmark       23
Creates a new child bookmark at the specified location.


Add a child bookmark       23
Inserts a bookmark as a child of the bookmark in the previous 
sample..


Remove a bookmark       23
Removes a bookmark and all children bookmarks from the 
bookmark tree.


Document Operations
Create a new blank PDF document       23
Creates a new document in the Acrobat viewer.


Metadata: Get document metadata       24
Allows you to retrieve and display document metadata.


Open an existing document       24
Opens the document whose filename is specified as the string 
argument.


Prompt user for a document to open       24
Executes the File Open menu item in Acrobat, which prompts the 
user for a file to open.


Links
Add navigation links to a page       24
This sample adds navigational links at the bottom of each page in 
the document.


Convert specified word to a weblink       25
Search for a word and create a weblink.


Convert URL text to live links       25
Convert all content that appears to be a URL into a web link.


Remove all links on a page       25
Removes all links on the current page.


Set an action for a link       26
Sets the specified JavaScript action for the Mouse Up trigger for 
the link object.


Menu operations
Add a new menu item       26
Adds a new menu item and an associated action.


Execute menu item       27
Executes the menu item specified by the argument.


Hide a menu item       27
Hides a menu item so user won’t have access to that item.


List menu items       27
Display a list of menu items for the Acrobat application; for use 
with methods that reference menu items.
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Messages/Dialogs
Beep the user       28
Causes the system to play a sound to alert the user.


Prompt the user for a response       28
Prompt and get a response from the user.


Simple alert       28
Displays a message to the user.


Navigation
Add a pop-up menu for navigation       29
Creates a pop-up menu that can be triggered by any of a variety of 
events.


Adding page numbers to a document       29
Adds page numbers to a document in the specified location, using 
the specified font style.


Get the number of the current page       29
Gets the current page number.


Go to a specified page number       30
Sample code to go to a specific page number.


Go to first page       30
Sets the page being viewed to the first page (zero-based 
numbering) in the document.


Go to next page       30
Increments the page being viewed to the next page.


Go to previous page       30
Navigates to the previous page of the document.


Go to last page       30
Sets the page being viewed to the last page in the document.


Go to another page: create a pop-up menu       30
Creates a pop-up menu which gives the user a choice of pages to 
which to go. The script can be attached to a button.


Add navigational arrows on every page       31
Add navigational symbols to every page of a  document for each 
document in a selected set.


OCG (Optional Content Group)
Beep when OCG state changes       31
Execute a JavaScript after every state change for a give OCG.


Show all OCG objects on the currrent page       31
Make visible all OCG objects in a specified name family.


Hide all OCG objects on current page       32
Hide all OCG objects in a specified name family.


Lock OCG objects       32
Locks the OCG so its state cannot be toggled through the UI.


Toggle the state of OCG objects       32
Specifies whether an OCG object is hidden or not.


Page Operations
Insert new page       32
Inserts a new page based on the selected template and then 
jumps to the new page.


Insert/Delete/Replace/Extract Pages       32
Executes a menu item to insert, delete, replace, or extract pages. 
The user is prompted to specify the appropriate pages.


Printing
Get a list of printers as a combo box       33
Shows how to get a list of printers and display result as a combo 
box.
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Print page using printer selected in combo box       33
Code to print the current page using the printer selected by user 
from the combo box presented in previous example.


Print only the current page       33
Sample code to print only the current page.


Print current page (no dialog)       33
Print the current page without the usual dialog.


Searching
A simple find operation       34
A alternative to the standard Acrobat search function; it can be 
used to create customized searches.


Spell checking
Creating a menu item to spellcheck a document       34
Spellchecks a document and uses annotations to mark the 
misspelled words. [Version 6.0 or higher]


Timing
Set countdown timer       35
Prompt the user for a time interval, and alert the user when that 
time has elapsed.


Viewing


Viewing Mode


Go to fullscreen mode and start slide show       36
Switches the viewer to full screen mode and starts a slide show.


Setting zoom values


Change zoom value       36
Set the zoom to a percentage of full size.


Prompt for a zoom value       36
Ask the user for a zoom value and set the view to that value.


Pop-up menus for zooming       37
The following example creates a pop-up menu which might be 
attached to a Mouse Up or Mouse Down action for a button field.


Watermarks
Adding a watermark from an external file       37
Add a watermark from an external PDF file to a selected range of 
pages in the current document.


Adding a watermark from text       37
Add specified text to current document as a watermark.
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JavaScript for Forms


Date handling


Acrobat reports and manipulates dates using the date 
object data structure, but dates are displayed in form 
fields as a string. Hence some conversion is required, as 
shown in the following examples.


Date timestamp: first time only


Gets today’s date as a one-time timestamp so it won’t be 
updated each time the page is opened.


The following code can be assigned as the Page Open 
action for the desired page. It checks to see if the value of 
the field has changed from its default value (usually it is 
blank). If it is the default value, then it gets the date and 
displays it as a string.


var today = new Date();
var td = this.getField("DateStamp");
// test if new value is the same as the
// default value, which was set to blank ("")
if (td.value == td.defaultValue) {
// if so, display formatted string in field
  this.getField("DateStamp").value = 
    util.printd("dd mmmm, yyyy",today);
}                     


// change field to "Read-only" 
this.getField("DateStamp").readonly = true;  


Date Parsing


Formats the current date using AFParseDateEx().


The following sample uses AFParseDateEx() to check 
the validity of the date and to display the resulting date 
formatted as a string. The user is alerted as to whether 
the parsing was successful or not. The code should be 
entered as a custom validation script for the field.


if(event.value) {
var DateOK = 


     AFParseDateEx(event.value,"mm/dd/yyyy");
if(DateOK != null) {


app.alert("date ok");
event.value = util.printd("mm/dd/yyyy", 


           DateOK);
}
else
{


event.value = "";
app.alert("date not ok");


}
}


Displaying a localized date 


Uses the util.printd method to display a localized date, 
including for CJK language documents. [Acrobat 7 or 
higher]


You can use the bXFAPicture parameter (optional, 
Acrobat 7 or greater; see Acrobat JavaScript Scripting 
Reference for more information) of the util.printd 
method to display a localized version of dates and times. 
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It uses the XFA-Picture Clause format to provide extensive 
support for localized dates and times for Chinese, 
Chinese (Taiwan), Japanese, and Korean (CCJK ) times and 
dates. It is supported for both Acro Form and XFA 
JavaScript.


The following is an example of util.printd being used 
to display the result in the JavaScript console, but it could 
also be used as an action for a page or document open 
event, or just to display the date in any field:


// execute in console
console.println(
util.printd("EEE, 'the' D 'of' MMMM, YYYY", 
   new Date(), true));


The result displayed in the console would be:


Tue, the 13 of July, 2004


The next example shows its use for localized output. The 
script can be entered as a custom format script of a text 
field. It gives the current date formatted for a Japanese 
locale (the last parameter is the bXFAPicture boolean 
set to true).


event.value = util.printd("date(ja){ggYY/M/
D}", new Date(), true)


Getting today’s date


Get today’s date and display it.


The following code can be attached to the Page Open 
event for the page on which the date will appear:


var today = new Date();


var td = this.getField("DateField");
td.value = util.printd("dd mmmm, yyyy",today);


This code will get and display a new date every time the 
page is opened. For a date timestamp that doesn’t 
change once it has been set, see “Date timestamp: first 
time only” on page 8.


Calculations


Calculations: Turn calculations on/off


Turn off calculations to optimize performance.


When a large number of fields are being checked or 
updated, each change of a field value can trigger all fields 
to be re-calculated, which can affect performance. 
Setting the calculate property of the doc object to 
false tells Acrobat not to execute the calculations until 
they are turned on again.


To turn off calculations until ready: 


this.calculate = false;


and to allow calculations to resume:


this.calculate = true;


Delay redrawing of appearance changes


Delays redrawing of all fields until all changes are 
completed.


this.delay = true;  // queue changes
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When set to false, all fields will be redrawn. See also the 
field.delay property in the Acrobat JavaScript 
Scripting Reference.


Field Operations


Add/Remove a new field programmatically


Places a new form field on the specified page. 


The following code, which can be executed from the 
JavaScript console, adds a text field named “myField” to 
the first page (zero-based) of the document. The field will 
be filled with yellow, and have a medium weight border. 


var aRect = [300, 660, 600, 700];
var f = this.addField("myField", "text", 0, 
   aRect);
f.fillColor = color.yellow;
f.strokeColor = color.red;
f.lineWidth = 2; // medium line width


and to remove the field:


this.removeField("myField");


N OTE: You can add an action to the newly-created field 
as shown in “Set an action for multiple fields” on 
page 18.


Add/Remove fields on multiple pages


Create or remove identical text fields on every page of a 
document.


The following code creates a field named “myField” on 
every page of a document. It could be entered through 
the JavaScript console, or in any other JavaScript code in 
the document.


for (var p = 0;  p < this.numPages; p++) {
var aRect = [300, 660, 600, 700];
var f = this.addField("myField", "text", 


       p, aRect);
f.strokeColor = color.black;


   f.fillColor = color.yellow;
}


With the above script, all added fields will have the same 
name, which means they will always all have the same 
value. One way to give them different names is to append 
the page number by changing the third line in the 
example above to:


var f = this.addField("myField" + p, 
     "text", p, aRect);


The result will be a new field on each page, named, for 
example, myField0, myField1, etc.


N OTE: Also see “Add navigational arrows on every page” 
on page 31 for another example of adding an 
action to all pages in a document.
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All of the added fields can be removed using the 
following code (for the sequentially-named fields):


for (var p = 0; p < this.numPages; p++)
var f = this.removeField("myField" + p);


Changing field properties


Change any or all of the properties of a form field. 


The following are examples of how to change the 
properties for a field, for a variety of commonly used field 
properties. For a complete list of properties and their 
values, see the JavaScript for Acrobat API Reference.


IMPORTANT: All of the following code samples use the 
variable f for the field object. So the 
following statement must precede any of 
the code samples:


var f = this.getField("MyField");


Alignment of a text field:


f.alignment = "center"; 


Background color:


f.fillColor = color.blue;


Current value:


// Set a variable to the field’s value
var v = f.value


Default value:


// Specify default value
f.defaultValue = "Enter your name here.";


Font:


f.textFont = font.Helv;


And for Acrobat 5.0 or higher, the PostScript® font name 
can be used for any font:


f.textFont = "Arial,BoldMT";


The first font name example above shows the use of an 
alias font name that is defined for a limited number of 
core fonts as defined in the Acrobat font object. The 
second example: Arial,BoldMT — shows the use of the 
font family name and style. You can also use the 
PostScript® font name, which you can see under the Fonts 
tab of the Document Properties window (press Ctrl-d 
when in Acrobat). For more details, see the JavaScript for 
Acrobat API Reference, under the properties for the Field 
object.


Font size:


f.textSize = 20;


Hide or display field:


f.display = display.noPrint;


Multiline field:


f.multiline = true;
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Password hiding – using asterisks:


f.password = true;


Required field:


f.required = true;


Stroke Color:


f.strokeColor = color.yellow;


Stroke line width:


f.lineWidth = 3;      // 3 = wide line


Color: defining a custom color


Define a custom RGB color for use, for example, as a form 
field background color.


color.lightYellow = new Array 
    ("RGB",1,0.99,0.8);


Check a check box field 


Inspect whether a check box field has been checked.


JavaScript can be used to see if a check box field has been 
checked by the user by inspecting the export value of 
that field (specified in the “Field Properties” dialog box). 


The following example contains code that toggles the 
state of the check box field. It could be attached as the 
Mouse Up action for a button field.


// Get named reference


var cB1 = this.getField("CheckBox1");


// check if export value is Yes
if (cB1.value == "Yes")


cB1.value = "No"  // if checked, toggle it
else


cB1.value = "Yes" // toggle back again


Or, the code could be written to use the event object:


if (event.target.value == "Yes") 
{do appropriate task}


Formatting a number in a form field


Shows how to format numbers in decimal, hex, and floating 
formats as well as formatting the value as a string.


You can cut-and-paste the following script into the 
JavaScript console, select the script, and press Enter. The 
resulting formatting is shown below under “Output.” (The 
“Math.PI” expression is a JavaScript constant equal to the 
value of ).


var n = Math.PI * 100;


// Decimal format:
console.println(util.printf("Decimal format: 
%d", n));


// Hex format:
console.println(util.printf("Hex format: %x", 
n));
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// Floating point format:
console.println(util.printf("Float format: 
%.2f", n));


// String format:
console.println(util.printf("String format: 
%s", n));


     Output:


Decimal format: 314
Hex format: 13A
Float format: 314.16
String format: 314.159265358979


Formatting: removing zeros so field is blank


Removes zeros (0.00) in auto-calculated fields.


Many times when form fields use predefined calculations, 
the resulting value may be zero. It is usually not 
desireable to display a value of “$0.00”. The solution is to 
use JavaScript to calculate the field values, and to include 
the following code in your calculations for each field:


if (event.value == 0)
event.value = "";


Hiding/un-hiding an existing field based on 
conditions


Hide or expose a field based on the state of a check box field.


A field may need to be hidden or exposed based on 
whether or not a check box is checked. The following 
code could be used, for example, as a Mouse Up action 
for the check box field. When the box is checked the 
“textField1” field is displayed; when the box is 
unchecked, the field is hidden.


// get name of text field to hide or not
var tF1 = this.getField("textField1")


// if box is checked, make text field visible
if (event.target.value == "Yes")  {
    tF1.hidden = false
}
else  {
    tF1.hidden = true
}


Highlighting a single field


Highlight a single field for the On Focus event, and turn off 
the highlighting for the On Blur event.


The following code can be set as the action for a single 
field (for example, “textField1”) that you want to highlight 
for the On Focus event (user tabs into or clicks on the 
field), and un-highlight at the On Blur event (when user 
leaves the field. 
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N OTE: If you want highlighting for multiple fields, see 
“Highlighting multiple fields using a for loop,” 
below.


var myField = this.getField("textField1");
if(event.name == "Focus")
    myField.fillColor = color.blue;
else if(event.name == "Blur")
    myField.fillColor = color.transparent;


Highlight fields using a function


Create a function to highlight a field, to be called from 
multiple fields.


The following example uses a Document JavaScript 
function ChangeColor() to handle all highlighting 
events. Then, you would add a ChangeColor() call to 
each field you would like highlighting applied, for both 
the On Focus and On Blur events. This function toggles 
the color of the field, so it can be called for both events.


function ChangeColor() {
  var myField = event.target;
  if(event.name == "Focus") {
    myField.fillColor = color.blue;
    myField.borderColor = color.black;
  }
  else if (event.name == "Blur")
    myField.fillColor = color.transparent;
}


Highlighting multiple fields using a for loop


Defines a Document Level JavaScript function that will 
highlight any field that calls the function when the mouse 
cursor enters that field. Code can be added to all fields by 
running a script from the JavaScript console.


The above example, “Highlighting a single field,” defines 
the ChangeColor() function which will change the 
color of a field as the user’s cursor enters or leaves a field 
(the On Focus and On Blur events, respectively).


Select Tools > JavaScript > Document JavaScripts, and in 
the resulting dialogue box enter a name and the 
ChangeColor() function shown in the above section, 
“Highlight fields using a function”.


Then, the following script can be run from the console to 
assign the ChangeColor() function (defined in the 
sample “Highlight fields using a functionon” on page 14) 
as the On Focus action for each field in the form. Run the 
following code from the JavaScript console: 


// loop through all fields in document
for (var i = 0; i < this.numFields; i++) {
  // set the ChangeColor function as the 
  // action for the field 
  var f = 
     this.getField(this.getNthFieldName(i));
  f.setAction("OnFocus", "ChangeColor();");
  f.setAction("OnBlur", "ChangeColor();");
}


The code will loop through all fields in the form and add 
the highlighting code to each field. For fields to which 
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you don’t want the actions to apply (such as for a button 
field), double-click them with the object selection tool to 
get the Field Properties window; click the Action tab; and 
then delete the attached script.


Locating fields and listing field names


List all form fields including their name, type, and page 
number.


Sometimes a complicated form may have many fields 
that are hard to find, or some fields may obscure other 
fields, or the field names may be too long to display 
clearly. The following script will output the names of all 
fields, the type, and the page number, to the console:


console.clear(); 
console.show();
console.println("Page, Name, Type");
for (var i=0; i<this.numFields; i++) {
  fieldName = this.getNthFieldName(i);
  f = this.getField(fieldName);
  console.println(f.page+ ", " + f.name + ", 
    " + f.type)
}


Another variation is the following script, which will place 
the name of each field below the field, and allow you to 
print the resulting form. The added field label is added in 
a new field created by the script, so it is intended only as a 
development tool to help identify fields.


This following script labels all fields in a form document; 
the print statement arguments should be adjusted for 
the pages yoou want to be printed.


// Define an array for field names
nameArray  = new Array (this.numFields); 


// Put all field names into an array
for (var i = 0; i<this.numFields; i++) 
   nameArray[i] = this.getNthFieldName(i);
// loop through name array
for (i=0; i<nameArray.length; i++) {
    // get object for existing field
    var f = this.getField(nameArray[i]); 
    // make a copy of rectangle coordinates
    var myRect = f.rect; 
    var name = f.name;
    // Get length of field name
    var flength = f.name.length;
    // myRect[1] = f.rect[3]; 
    myRect[3] = f.rect[3] - 10;
    myRect[2] = f.rect[0] + (flength * 3);
    // make a new field just under old one
    f = this.addField("abyz" + i, "text", 
        this.pageNum, myRect);
    f.value = name;
}
this.print(true, this.pageNum, this.pageNum);


In the above example, the field bounding box 
coordinates are returned for rotated user space, and are 
in this order: ulx (upper-left x), uly (upper-left y), lrx 
(lower-right x), and lry (lower-right y), which is different 
from bounding boxes for annotation rectangles.
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Printing: Set field to print or not print


Code to control the print property of a field so the field will 
either print or not print.


var f = this.getField("myField");
f.print = false;


N OTE: Most printing examples are in the JavaScript for 
Documents section under “Printing” on page 33.


Print selected form pages


Print a selected range of form pages (for example, to exclude 
the instruction pages in a form document).


Some forms consist of one or more pages of instructions 
which don’t need to be printed. The following example 
might be for a form where the first page contains only 
instructions, and the second page contains the form and 
a print button. Hence the page range parameters both 
point to the second page:


this.print(false,this.pageNum,this.pageNum);


Rollover help


Two methods for providing rollover help include: 
1) descriptive help text can be displayed; or 2) a default 
text or value can be displayed. In both cases, the rollover 
help text should be displayed for the Mouse Enter event, 
and it can be removed for the Mouse Exit event. 


The first example below shows how to display help text, 
but it could also be used to display the default value by 
using the defaultValue property of the field.


N OTE: Basic “rollover” highlighting of a form field is 
shown in “Highlighting a single field” on page 13.


Display help text


Display help text for a field for the Mouse Enter event.


For a Mouse Enter event:


var f = this.getField("Text1");
f.value = "Enter full e-mail address"


And for the Mouse Exit event:


// Remove help text only if present
var f = this.getField("Text1")
f.value = "";


The problem with the above code is that it works fine 
when the mouse enters and leaves the field, but when 
the user clicks in the field to enter data, the help text is 
not removed. Also, if the user did remove the help text 
manually and then entered data, the next time the 
mouse passed over the field, the user data would be 
removed.


The following improved script checks field contents 
before changes are made. It adds an On Focus event 
(when the user tabs to, or clicks in, the field) to 
distinguish when the user begins to enter data.
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For the Mouse Enter event:


//Display help text only if field is blank
var f = this.getField("Text1")
if (f.value == "")
    f.value = "Enter full e-mail address";


For the Mouse Exit event:


// Remove field text but only if it is the
// text from the Mouse Enter event, otherwise
//   user input could be deleted
var f = this.getField("Text1")
if (f.value == "Enter full e-mail address")
       f.value = "";


For the On Focus event:


// Reset field to blank only if 
//     help text is present
var f = this.getField("Text1")
if (f.value == "Enter full e-mail address")
    f.value = ""


Search fields


Search for all fields with a specified prefix


Search/enumerate through all fields that begin with 
specified string.


The following code loops through all fields in the form 
and displays field names that begin with (for example) 
“txt”.


for (var i = 0; i < this.numFields; i++) {


 if (this.getNthFieldName(i).substring(0,3) 
      == "txt")
  app.alert(this.getNthFieldName(i));
  
  // or to list in console window:
  // console.println(this.getNthFieldName(i))
}


The above code uses the JavaScript substring method. It 
specifies the beginning index of the string (0) and the 
length of the string it is trying to match (3) . The code can 
be entered in the JavaScript console as means of locating 
and potentially altering all fields with a given name 
(using additional code), or it could be an action 
associated with a button, or be used in any other script 
associated with the form.


Set an action for a single field


Attaches an action to a single field.


The following code sets the function ChangeColor() 
(defined on page 13) as the action for the field named 
myField, for both the On Focus and On Blur events.


var f = this.getField("myField");
f.setAction("OnFocus", "ChangeColor();");
f.setAction("OnBlur", "ChangeColor();");
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Set an action for multiple fields 


Execute code from the JavaScript console to attach an 
action to multiple fields.


A script to set an action for multiple fields is shown in 
“Highlighting multiple fields using a for loop” on page 14. 
The function call and the actions can be modified to suit 
whatever is needed. The script adds the specified actions 
to all fields in the document. Depending on the form, it 
might be easier to add the actions to all fields using a for 
loop, and then deleting by hand the actions for the fields 
that do not need those actions.


Form checking and resetting


Final field checks


Check fields before submitting


Check that all required fields were completed before the 
form is submitted. 


The following code loops through all fields, allowing you 
to verify, check, or validate each field before the form is 
submitted. The code could be used, for example, as part 
of the action for a “Submit” button.


for (var i=0; i<this.numFields; i++) {
   var strFieldName = 
      this.getNthFieldName(i);
   var field = this.getField(strFieldName);


if (field.value == "") {


     // Add your tests here 
     // Build a list of names and pages
     // to alert user


}
}


The following script checks all fields for a prefix of 
“required.” (for example, required.username). It then 
checks if an entry has been made in that field, and alerts 
the user if no data has been entered.


for (var i=0; i<this.numFields; i++)  {
 if (this.getNthFieldName(i).substring(0,8) 
     == "required"){
   var f1 = 
   this.getField(this.getNthFieldName(i));
   if (f1.value == "") {
     app.alert(this.getNthFieldName(i) + "  
     is a required field; please enter 
     data");
   f1.setFocus();}
  }
}


Another option would be to put the names of all required 
fields in an array; in this example they are hard-coded in 
the script. The user clicks a button and is alerted as to 
which fields are blank. They then enter the data, and click 
the button again until no error messages are displayed.


// Specify a list of required field names:
var requiredField = ["Text10", "Text11", 
"Text12"];
// Loop through the array of field names:
for (var i=0; i<requiredField.length; i++){
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   var f = this.getField(requiredField[i]);
   if (f.value == ""){
     app.alert("The " + requiredField[i] + " 
field is required; please click OK on this 
message; enter data; and then click this 
button again until there are no error 
messages")
   break;
   }
   else if(i == requiredField.length - 1) {
       app.alert("Thank you, all required 
fields have been completed");
   }
}


Resetting a form


Resets all fields, or specified fields, to their original default 
value.


The doc object method resetForm(), with no 
arguments, will reset all fields in the form to their default 
value:


this.resetForm();


It could be set as the action for a “Reset Form” button. 


If the default is not set to a specfied value, (which means 
the value is Null ), the above method has the effect of 
clearing the fields so they are left blank.


If you want to reset a subset of all fields, you need to 
specify an array that contains the names of all fields to be 
reset. For example, the following code builds an array of 


two field names and passes the array name as the 
parameter to the resetForm() method:


var f = new Array(2);
f[0] = "textField";
f[1] = "totalField";
this.resetForm(f);


You could use the following alternate syntax for setting 
up the array: 


var f = new Array("textField", "totalField");


Or you could use the Acrobat naming convention; for 
example, if you want to reset all name fields, and they are 
named name.first, name.last, etc., then the 
following will reset all fields that begin with “name”:


var a = new Array(1);
a[0] = "name"
this.resetForm(a);


If you want to set a field to be blank (Null) even though its 
default value is something else, you can set it to Null by 
using the null string, which consists of two double-quote 
characters:


var f = this.getField("myField");
f.value = "";







Forms: Code Samples
A C R O B A T  C O M M O N  T A S K S  J AV ASC R I PT  C O L L E C T I O N 20


   About               Forms                 Documents               Actions                Testing                Resources                  Index 


Validation


Validate that number is in the correct range


Verify that entered value is in one of two ranges.


Standard Acrobat validation can be used for simple 
validations such as whether a number is in a given range, 
but a custom script can be used for other types of 
validations. The following script would be defined as a 
custom validation script to be run after a value is entered.


if ((event.value >= 40 && event.value <=200) 
  || (event.value 
  >= 1000 && event.value <= 2000)) 
     event.rc = true ; 
else { 
  app.alert("value out of range"); 
  event.rc = false ; 
}


Verify that required entry was made


Check required fields for a valid entry.


A field’s properties can be set through the Acrobat UI to 
indicate that it is a required field, but that field property is 
not checked for a data entry value until the form is 
submitted (this example is similar to the example “Check 
fields before submitting” on page 18).


There can be situations where you might want to check if 
specific required entries have been made, before the user 
can proceed to other pages. Or you might want to give 


them a choice in a dialog to leave some fields blank and 
return later.


The following code will check a required field to verify 
that required information has been entered (it checks to 
see if the field’s value is not Null). 


f1 = this.getField("employeeNumber")
if (f1.value == "") {
   app.alert('Please enter your employee 
   number');
}


Another way to check required fields before they are 
submitted would be by using a field name prefix of 
“required”. You could then use the following code which 
uses the substring() method to identify fields whose 
names begin with “required”:


// Enumerate through all fields 
for (var i = 0; i < this.numFields; i++)
{
  if (this.getNthFieldName(i).substring(0,8)  
     == "required"){


var f1 = 
     this.getField(this.getNthFieldName(i));


if (f1.value == "") {
app.alert(this.getNthFieldName(i) + " 


      is a required field!");
f1.setFocus();


}
  }
}


When a required field has a null value, the Focus is set to 
that field (f1.setFocus()) so the user can enter 
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required information. You might want to also change the 
border style or fill color of that field to draw attention to 
it, and then reset those properties when data entry has 
been completed.


Another method would be to loop through all fields, as 
above, and check for the required property for each field. 


for (var i = 0; i < this.numFields; i++) {
var f = this.getNthFieldName(i);
var f1 = getField(f);
if (f1.required == true){


if (f1.value == "") {
app.alert(this.getNthFieldName(i) + 


            "is a required field!")
}


}
}


Convert user input to uppercase characters


Converts lowercase characters typed by the user into 
uppercase characters.


The following code could be used as a custom keystroke 
script which will change all lowercase characters to 
uppercase (non-lowercase characters typed by the user 
will not be affected).:


// Custom keystroke for text field
if (!event.willCommit) 
   event.change = 
     event.change.toUpperCase();


Restricting keystrokes to uppercase characters


Restrict keystrokes to Y (for Yes) or N (for No) .


The following custom keystroke script will only allow the 
user to type Y or N (or y or n). 


if (!event.willCommit) {
  if (event.change.match(/[YN]/))  {
    event.rc = true;
  }
  else {
    app.beep();
    event.rc = false;
  }
}
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JavaScript for Documents
This section contains sample JavaScripts formany PDF 
document operations.


Annotations


Add/remove annotations


Create an annotation


Illustrates how to create an annotation of type “Text”.


try {
//  Create a document
var myDoc = app.newDoc();


//  Create an annot
var  myAnnot = myDoc.addAnnot
({


page: 0,
type: "Text",
point: [300,400],
name: "myAnnot",


});
} catch (e) {
app.alert(e);
}


Remove an annotation


Removes an annotation.


The following code will remove all annotations of the 
type “Text”, on the first page of the document (page 0 in a 
zero-based numbering system):


var annots = this.getAnnots({nPage:0});
for (var i = 0; i < annots.length; i++)


if (annots[i].type == "Text") 
          annots[i].destroy();


Application Version


Version checking


Checks the version and type of the Acrobat application, and 
lists all plug-ins.


This script could be run from the console or attached to a 
button, or included with other JavaScript code in a 
document.


// Query App version and output results


var echo = this.getField("Text_output");
echo.value = "Viewer type is " + 
   app.viewerType;
echo.value += "\n" + "Viewer version is " + 
   app.viewerVersion;


// Now get array of plug-in names
var aPlugins = app.plugIns;
//Get number of plug-ins
var nPlugins = aPlugins.length;
//Enumerate names of all plug-ins
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for (var i = 0; i < nPlugins; i++)
console.println("Plug-in \#"+i+" is " + 


aPlugins[i].name);


N OTE: This code works for Acrobat 5.0 or newer; for 
earlier versions, see JavaScript for Acrobat API 
Reference.


Bookmarks
To create a new bookmark, invoke the Bookmark object 
createChild method, to which you may submit the 
following parameters: cName (the name to appear in 
the navigational panel), cExpr (an optional JavaScript 
to be executed when the bookmark is clicked), and 
nIndex (an optional zero-based index into the 
children array).


N OTE: Bookmarks cannot be created or removed in 
Acrobat Reader.


Create a new bookmark


Creates a new child bookmark at the specified location.


Begin by accessing the bookmarkRoot, which is a 
property of the current document representing the top 
node in the bookmark tree, and then creating a child 
bookmark that displays a greeting when clicked:


var myRoot = this.bookmarkRoot;
myRoot.createChild("myBookmark", "app.alert('
   Hello!');");


Add a child bookmark


Inserts a bookmark as a child of the bookmark in the 
previous sample..


The bookmark generated in this example will be named 
“myBookmarkChild,” and the associated action is to 
display the message “Hello child.”


var current = myRoot.children[0];
current.createChild("myBookmarkChild", 
  "app.alert('Hello child!');");


Remove a bookmark


Removes a bookmark and all children bookmarks from the 
bookmark tree.


bookmarkRoot.remove();


You can remove a specific bookmark, or the above 
command will remove all bookmarks in the tree.


Document Operations


Create a new blank PDF document


Creates a new document in the Acrobat viewer.


Because of security restrictions, this code can only be 
executed during batch, console, or menu events. 
Running it in the console is an easy way to generate a 
blank PDF document for testing purposes.


app.newDoc();
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Metadata: Get document metadata


Allows you to retrieve and display document metadata.


Document metadata is stored in a PDF file as XML data. 
This sample  gets the path and filename of the 
document, and also the XML text for the document 
metadata. The following code can be set as an action 
attached to a button: 


// Display metadata in the
// Text_meta.filename, Text_meta.fpath,
// and Text_meta.data fields


this.getField("Text_meta.fpath").value = 
this.path;
this.getField("Text_meta.filename").value= 
this.documentFileName;
this.getField("Text_meta.data").value=this.m
etadata;


and the following script could be set as the action for a 
button labelled “Clear”:


//Clear the fields:
var fields = this.getField("Text_meta");
this.resetForm(fields);


Open an existing document


Opens the document whose filename is specified as the 
string argument.


app.openDoc("MyFile.pdf");


Prompt user for a document to open


Executes the File Open menu item in Acrobat, which 
prompts the user for a file to open.


app.execMenuItem("Open");


I MP OR TA N T: As of Acrobat 8, this method can only be 
executed in Privileged mode, which means 
during batch or console events. See Note 
under “Execute menu item” on page 27.


Links


Add navigation links to a page


This sample adds navigational links at the bottom of each 
page in the document.


This sample creates two navigtaion links for each page. 
For this example, the links direct the user to either page 0 
or 2, such as might be used to go to the cover page or the 
Table of Contents page of a document.


The links could also be placed over custom navigation 
images in the document. This script can also be run from 
the JavaScript console.


// Define two link rectangles
var linkRect1 = [70, 70, 225, 50];
var linkRect2 = [260, 70, 340, 50];


// For pages 0 to n (or range of your choice)
for ( var i=0; i < this.numPages;  i++ ) {
    // Add link for current page, "i"
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    var link1 = this.addLink(i, linkRect1);
 link1.borderWidth = 3;
 link1.borderColor = color.blue;


    var link2 = this.addLink(i, linkRect2);
 link2.borderWidth = 3;
 link2.borderColor = color.blue;


    // For this example, link to pages 0 & 2;
    // (For example, the Cover page 
    // and Table of Contents pages


 link1.setAction("this.pageNum = 0");
    link2.setAction("this.pageNum = 2");
}


Convert specified word to a weblink


Search for a word and create a weblink.


var p = this.pageNum;
var numWords = this.getPageNumWords(p);
for (var i=0; i<numWords; i++)
{
  var ckWord=this.getPageNthWord(p, i, true);
  if ( ckWord == "Acrobat") {


var q = this.getPageNthWordQuads(p, i);
// convert quads in Default User Space to 


   //  Rotated User Space used by Links.
m = (new Matrix2D).fromRotated(this,p);
mInv = m.invert()
r = mInv.transform(q);
r = r.toString();
r = r.split(",");
l = addLink(p, [r[4], r[5], r[2], r[3]]);
l.borderColor = color.red;
l.borderWidth = 1;


l.setAction("this.getURL('http://
www.adobe.com/products/acrobat', false);");
    }
}


Convert URL text to live links


Convert all content that appears to be a URL into a web link. 


The following sample will convert all URLs in the 
document into a weblink and display the number of links 
created. The code can be entered and executed in the 
console.


var numWeblinks = this.addWeblinks();
console.println("There were " + numWeblinks +
" instances of text that looked like a web 
address,");


Remove all links on a page


Removes all links on the current page.


The following code can be entered in the JavaScript 
console, either for the current page, or it could be used in 
a loop to remove links for multiple pages. It first gets the 
coordinates of the current page, and then tells the doc 
object to remove all links within that rectangle.


var b = this.getPageBox("Crop", 
   this.pageNum);
this.removeLinks(this.pageNum, b);
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Set an action for a link


Sets the specified JavaScript action for the Mouse Up trigger 
for the link object.


Link.setAction specifies the action for the Mouse Up 
trigger for the link object, which is obtained from 
doc.addLink or doc.getLinks. 


For this example, the action (this.pageNum++) causes 
the viewing application to go to the next page:


link.setAction("this.pageNum++");


Menu operations


N OTE: This section contains tasks related to application 
menu items. For an example of how to add your 
own pop-up menus, see: “Pop-up menus for 
zooming” on page 37.


Add a new menu item


Adds a new menu item and an associated action.


This first example adds a menu item to the top of the file 
submenu and it puts up an alert dialog displaying the 
active document title. This menu item is only enabled if a 
document has been opened.


N OTE: Because of security constraints, code to add or 
hide menu items can only be used in the 
JavaScript console or in folder level JavaScript files 
which execute when the application is opened. 


The menu changes will then apply to all PDF files 
that are opened by the application.


Example 1


Adds a “Hello” entry to the File menu; when selected, the 
menu item title is displayed on the user’s screen.


app.addMenuItem({ 
cName: "Hello", 
cParent: "File",
cExec: "app.alert(event.target.info.title, 


      3);",
cEnable: "event.rc = (event.target != 


      null);",
nPos: 0


});


Example 2    [ Acrobat version 6.0 or newer]


Places two menu items in the “File” menu, one before the 
“Close” item, and the other after the “Close” item. The 
names “_myProc1” and “_myProc2” are placeholders for 
the JavaScript procedures you would write to handle the 
intended task for the menu items you are adding.


// insert after the "Close" item 
//    (the default behavior)
app.addMenuItem( { 


cName: "myItem1", 
cUser: "My Item 1", 
cParent:"File", 
cExec: "_myProc1()", 
nPos: "Close"});


// insert before the "Close" item, 
//   set bPrepend to true.
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app.addMenuItem( { 
cName: "myItem2", 
cUser: "My Item 2", 
cParent: "File", cExec: "_myProc2()",
nPos: "Close", bPrepend: true 


});


Execute menu item


Executes the menu item specified by the argument.


For example:


app.execMenuItem("Open");


will execute the menu item File > Open, which will 
prompt the user for the file to be opened.


N OTE: As of Acrobat 8, the execMenuItem method is 
restricted to a short list of safe menu entries. It will 
silently fail if a named menu item is executed that is not 
on the safe menu list. The JavaScript developer is 
notified that menu items may be removed in future 
releases, or their behavior may change. The 
app.execMenuItem method may be executed, 
without restriction, in a privileged context, such as in 
the console or in a batch sequence. For folder 
JavaScript, app.execMenuItem can be executed, 
again, without restriction, through a trusted function 
with raised privilege. See JavaScript for Acrobat API 
Reference for more information.


Hide a menu item


Hides a menu item so user won’t have access to that item.


N OTE: Because of security constraints, code to add or 
hide menu items can only be used in the 
JavaScript console or in folder level JavaScript files 
which execute when the application is opened. 
The menu changes then apply to all PDF files that 
are opened by the PDF viewer.


app.hideMenuItem("Edit");


N OTE: See List menu items below to get exact menu 
names.


List menu items


Display a list of menu items for the Acrobat application; for 
use with methods that reference menu items.


In order to hide or execute a menu item, you need to 
know the exact name of the menu item.


Example 1


List all menu item names to the JavaScript console.


var menuItems = app.listMenuItems()
for (var i in menuItems)


console.println(menuItems[i] + "\n");


Example 2


List all menu items to console, but more nicely formatted.


function FancyMenuList(m, nLevel) {
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var s = "";
for (var i = 0; i < nLevel; i++) s += " ";
console.println(s + "+-" + m.cName);
if (m.oChildren != null)
for (var i = 0; i < m.oChildren.length; i++)


FancyMenuList(m.oChildren[i], nLevel + 1);
}
var m = app.listMenuItems();
for (var i=0; i < m.length; i++) 
   FancyMenuList(m[i], 0);


Messages/Dialogs


Beep the user


Causes the system to play a sound to alert the user.


app.beep();


Prompt the user for a response


Prompt and get a response from the user.


The user’s response is returned as the value of the 
variable reply. That string can then be tested using an 
if statement.


var dialogTitle = "Please confirm";
var defaultAnswer = "No.";
var reply = app.response("Did you really mean 
to type that?", dialogTitle, defaultAnswer);


Simple alert


Displays a message to the user.


The following code posts a simple alert message:


app.alert("Error! Incorrect entry");


The app.alert object also allows you to customize by: 
1) using your own title instead of the standard Acrobat 
title;  2) displaying your choice of icons; 3) choosing the 
type of buttons shown to the user. The following 
example uses a few of those options (the optional 
cTitle parameter is only supported for Acrobat 6 or 
newer):


app.alert({
cMsg: "Error! Incorrect entry!\n\tYou may 


want to try again",
cTitle: "Acme Corporation"


});


In this example, the default title “Adobe Acrobat” was 
replaced by “Acme Corporation”, and a second line of the 
message is begun on a new line (\n), and a tab is set (\t) 
to indent it.


For more information, see the JavaScript for Acrobat API 
Reference.
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Navigation


Add a pop-up menu for navigation


Creates a pop-up menu that can be triggered by any of a 
variety of events. 


This script could be attached as the action for a 
“Navigation Menu” button (for example), which could be 
placed at strategic locations in a document. 


// pops up a menu for going to other pages
var cChoice = app.popUpMenuEx
(


{cName: "Cover page", bEnabled:false},
{cName: "-"},
{cName: "Page 2", cReturn: "2"},
{cName: "More",


oSubMenu: [ 
{cName: "Page 3", cReturn: "3"},
{cName: "More",


oSubMenu: [
{cName:"Page 4", cReturn: "4"},
{cName:"Page 5", cReturn: "5"}


    ] 
     }


]
},
{cName: "Last page" },
{cName: "-"},
{cName: "Beep On", bMarked:global.bFlag}


)
//app.alert("You chose the \"" + cChoice + 
"\" menu item");


if(!isNaN(parseInt(cChoice)))
    this.pageNum =parseInt(cChoice) - 1; 
else if(cChoice=="Last page") 
    this.pageNum = this.numPages - 1;
else if(cChoice=="Beep On") 
     global.bFlag = ! (global.bFlag);
if(global.bFlag) app.beep(0); 


Adding page numbers to a document


Adds page numbers to a document in the specified location, 
using the specified font style.


var r =[612 -72, 792 -72, 612, 792];
// 1 inch from top right
for( var i = 0; i < numPages; i++) {
  // Get page number string
  var fn = String("page"+i+1);
  var f = this.addField(fn,"text",i,r);
  f.textSize = 14;
  f.textColor = color.blue;
  f.fillColor = color.transparent;
  f.textfont = font.HelvB;
  f.borderStyle = border.s;
  f.strokeColor = color.transparent;
  f.value = String(i+ 1);
}


Get the number of the current page 


Gets the current page number.


var currentPage = this.pageNum;
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Go to a specified page number


Sample code to go to a specific page number.


// Go to page 20 (zero-based page numbers)
this.pageNum = 20;


Go to first page


Sets the page being viewed to the first page (zero-based 
numbering) in the document.


this.pageNum = 0;


Go to next page


Increments the page being viewed to the next page.


this.pageNum++;


Go to previous page


Navigates to the previous page of the document.


this.pageNum--;


Go to last page


Sets the page being viewed to the last page in the 
document.


this.pageNum = this.numPages - 1;


N OTE: Because the JavaScript page numbering is zero 
based, if the number of pages in the document is, 


for example, 45, then the zero-based number of 
that page will be 44.


Go to another page: create a pop-up menu


Creates a pop-up menu which gives the user a choice of 
pages to which to go. The script can be attached to a button.


// pops up a menu for going to other pages
var cChoice = app.popUpMenuEx
(


{cName: "Cover page", bEnabled:false},
{cName: "-"},
{cName: "Page 2", cReturn: "2"},
{cName: "More",


oSubMenu: [ 
{cName: "Page 3", cReturn: "3"},
{cName: "More",


oSubMenu: [
{cName:"Page 4", cReturn: "4"},
{cName:"Page 5", cReturn: "5"}


    ] 
     }


]
},
{cName: "Last page" },
{cName: "-"},
{cName: "Beep On", bMarked:global.bFlag}


)


//app.alert("You chose the \"" + cChoice + 
"\" menu item");
if(!isNaN(parseInt(cChoice)))
    this.pageNum =parseInt(cChoice) - 1; 
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else if(cChoice=="Last page") 
    this.pageNum = this.numPages - 1;
else if(cChoice=="Beep On") 
     global.bFlag = ! (global.bFlag);
if(global.bFlag) app.beep(0); 


Add navigational arrows on every page


Add navigational symbols to every page of a  document for 
each document in a selected set.


The following sample code can be used in a batch 
sequence or as folder level JavaScript, or you can execute 
it from the JavaScript console.


var inch = 72;
for (var p = 0; p < this.numPages; p++) {
  // position rectangle (.5 inch, .5 inch)
  var aRect = this.getPageBox( {nPage: p} );
  aRect[0] += .5*inch; // from upper left 
  aRect[2] = aRect[0]+.5*inch; // .5” wide
  aRect[1] -= .5*inch;
  aRect[3] = aRect[1] - 24; // 24 points high
  // now construct button field with a right 
  //   arrow from ZapfDingbats
  var f = this.addField("NextPage", "button", 
     p, aRect )
  f.setAction("MouseUp", "this.pageNum++");
  f.delay = true;
  f.borderStyle = border.s;
  f.highlight = "push";
  f.textSize = 0; // auto sized
  f.textColor = color.blue;
  f.fillColor = color.ltGray;
  f.textFont = font.ZapfD


  f.buttonSetCaption("\341") // a right arrow
  f.delay = false;
}


N OTE: For another method for adding navigational links 
to document pages, see “Add navigation links to a 
page” on page 24.


OCG (Optional Content Group)
OCG objects (images or text) can be selectively viewed or 
hidden content in a PDF document using JavaScript.


Beep when OCG state changes


Execute a JavaScript after every state change for a give OCG.


/* Beep when the given OCG is changed */
function BeepOnChange(ocg) {
   ocg.setAction("app.beep()");
}


Show all OCG objects on the currrent page


Make visible all OCG objects in a specified name family.


The following code gets a list of all OCG objects on the 
current page, loads them into an array, and then sets 
their state to true, which makes them visible. It could be 
set as the action for a button to display a given set of OCG 
objects.


var ocgArray = this.getOCGs(this.pageNum);
for (var i=0; i < ocgArray.length; i++)
    ocgArray[i].state = true;
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Hide all OCG objects on current page


Hide all OCG objects in a specified name family.


The following code gets a list of all OCG objects on the 
current page, loads them into an array, and then sets 
their state to false, which hides them. It could be set as 
the action for a button to hide a given set of OCG objects.


var ocgArray = this.getOCGs(this.pageNum);
for (var i=0; i < ocgArray.length; i++) {
    ocgArray[i].state = false;
}


Lock OCG objects


Locks the OCG so its state cannot be toggled through the UI.


This sample locks all OCG objects on the current page:


var ocgArray = this.getOCGs(this.pageNum);
for (var i=0; i<ocgArray.length; i++) 
    ocgArray[i].locked = true;


Toggle the state of OCG objects


Specifies whether an OCG object is hidden or not.


This code could be associated with a button that toggles 
whether a watermark graphic or text is hidden or not.


// Get list of OCG objects for current page
var ocgArray = this.getOCGs(this.pageNum);


// If name begins with "Watermark", 
//     toggle its display state


for (var i=0; i < ocgArray.length; i++) {
    if (ocgArray[i].name == "Watermark")
      ocgArray[i].state =!ocgArray[i].state;
}


Page Operations


Insert new page


Inserts a new page based on the selected template and then 
jumps to the new page.


The following code selects the first template in the 
document, and adds a new page at the end.


// get the template
var t = this.getNthTemplate(0);


// spawn a new page after last page
this.spawnPageFromTemplate(t);


// go to new page:
this.pageNum = this.numPages-1;


Insert/Delete/Replace/Extract Pages


Executes a menu item to insert, delete, replace, or extract 
pages. The user is prompted to specify the appropriate 
pages.


For example, to delete pages:


app.execMenuItem("DeletePages");
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IMPORTANT: See the note about security restrictions 
under “Execute menu item” on page 27.


The other page operation menu options include: 
InsertPages, ExtractPages, and ReplacePages.


Printing


Get a list of printers as a combo box


Shows how to get a list of printers and display result as a 
combo box.


The following code could be set as the action for a button 
to get a list of available printers and populate the combo 
box with that list:


this.getField("ComboBox_printers").setItems(
app.printerNames);


Print page using printer selected in combo box


Code to print the current page using the printer selected by 
user from the combo box presented in previous example.


This example uses the printer selected from the combo 
box created in the example above. The current page of 
the document is printed to that printer.


// get printParams object of default printer
var pp = this.getPrintParams();


// print this page
pp.firstPage = this.pageNum;
pp.lastPage = this.pageNum;


// set some properties
pp.interactive = 
  pp.constants.interactionLevel.automatic;
pp.colorOverride = 
  pp.constants.colorOverrides.auto;


// use the printer selected
var f = this.getField("ComboBox_printers");
var aPrinter = f.valueAsString;
if(aPrinter!=null) pp.printerName = aPrinter;


// print
this.print(pp);


Print only the current page


Sample code to print only the current page.


The following code causes the user to be prompted with 
the printing dialog box:


this.print(true,this.pageNum,this.pageNum);


The first parameter, true, specifies that the print UI wil be 
presented to the user to obtain printing information and 
confirm the action.


Print current page (no dialog)


Print the current page without the usual dialog.


// first param = false = no dialog 
this.print(false,this.pageNum,this.pageNum);
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Searching 


A simple find operation


A alternative to the standard Acrobat search function; it can 
be used to create customized searches.


The following sample shows a folder level JavaScript to 
add a new menu item “Find” to the Tools menu.


app.addMenuItem({ 
cName: "Find", 
cParent: "Tools", 
cExec: "easyFind()"


});


function easyFind() {
    var wordToFind = app.response({
       cQuestion:"Enter the word you wish to 
search for",


  cTitle:"Quick Search"
});
if(wordToFind != null) 
  search.query(wordToFind, "ActiveDoc")


};


Also, it is easy to specify search parameters to improve 
the quality of the search. The following code from the 
easyFind() function shown above illustrates more 
possibilities:


    if(wordToFind != null) {
  // what to search:
  search.bookmarks = true;       // 6.0
  search.attachments = true;     // 7.0
  search.docXMP = true;          // 6.0
    
  // how to match:
  search.matchWholeWord = true;  // 6.0


   search.matchCase = true;       // 6.0
  search.matchWholeWord = true;  // 6.0


   search.ignoreAccents = true;   // 7.0


  // do search:
  search.query(wordToFind, "ActiveDoc")


    }


The above example specifies the scope of what will be 
searched, and the rules for how to match.


N OTE: The comment next to each search property 
indicates the version number of Acrobat that 
supports that feature. See the JavaScript for 
Acrobat API Reference for more information.


Spell checking


Creating a menu item to spellcheck a document


Spellchecks a document and uses annotations to mark the 
misspelled words. [Version 6.0 or higher]


The spell checking can be done by creating a folder level 
JavaScript that creates a custom menu item to do the 
spellchecking. This sample is similar to the spell checker 
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in Acrobat, except that with JavaScript the search 
parameters can be customized.


app.addMenuItem({ 
cName: "SpellCheck", 
cParent: "Tools",
cExec: "SpellCheck();"


});


function SpellCheck(){
  var ckWord, numWords;
  for (var i = 0; i < this.numPages; i++) {
    numWords = this.getPageNumWords(i);
    for (var j = 0; j < numWords; j++) {
      ckWord = 
     spell.checkWord(this.getPageNthWord(i, j))
      if ( ckWord != null ) {
        this.addAnnot({


   page: i,
   strokeColor: color.red,
   type: "Squiggly", 
quads: this.getPageNthWordQuads(i, j),
author: "JavaScript SpellChecker",
contents: ckWord.toString()


     });
   }
}
}
app.alert ("Acrobat is done spell checking the 
current document",3)
}


Timing


Set countdown timer


Prompt the user for a time interval, and alert the user when 
that time has elapsed.


Setting a timer can be used for many purposes, but as a 
simple example, the following code prompts the user to 
enter the number of seconds, and when the time has 
elapsed, a message is displayed.


function TimedOut() {
    app.alert ("The time has elapsed");


 // cancel the timer:
    app.clearInterval(timeout);
}
// Prompt for number of seconds
var secondCount = app.response("Enter number 
of seconds", "Number of Seconds", "", "")
// Start counter
if (secondCount >= 0)
// Timer set for thousandths of a second
var timeout = app.setInterval("TimedOut()", 
    1000*secondCount);
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Viewing


Viewing Mode


Go to fullscreen mode and start slide show


Switches the viewer to full screen mode and starts a slide 
show.


The following code could be attached as the action for a 
“Click Me” or “Start Slideshow” button action. 


this.pageNum = 0;
// full screen
app.fs.cursor = cursor.visible;
app.fs.defaultTransition = "WipeDown";  // 
BoxIn, BoxOut
app.fs.timeDelay = 2; // delay 2 seconds
app.fs.useTimer = true; // activate 
automatic page turning
app.fs.usePageTiming = true; // allow page 
override
app.fs.clickAdvances = true;
app.fs.escapeExits = true;
app.fs.loop = true;
app.fs.backgroundColor = color.ltGray;


// go 
app.fs.isFullScreen = true;


Setting zoom values


Change zoom value


Set the zoom to a percentage of full size.


this.zoom = 40;    // Set to 40% zoom


Prompt for a zoom value


Ask the user for a zoom value and set the view to that value.


It may be useful to have a button which, when clicked, 
prompts the user to change the zoom value. For 
example, some PDF files may specify that the tool bars be 
hidden when the document is viewed, so the zoom tools 
are not readily available. Also, this might be useful for the 
situation where some OCG (Optional Content Group) 
objects are only visible at certain zoom values.


// Prompt for a value:
var zoomValue = app.response({


cQuestion:"Enter zoom value:",
cTitle:"Zoom Percentage",


})


// Check if Null; if so, don’t change value 
if(zoomValue == "")   
    app.alert("No value entered");
else
    this.zoom = zoomValue;
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Pop-up menus for zooming


The following example creates a pop-up menu which might 
be attached to a Mouse Up or Mouse Down action for a 
button field.


// pops up a menu for various zoom choices
var cChoice = app.popUpMenuEx(
    {cName: "Zoom options:"},


{cName: "-"},
{cName: "Zoom In", cReturn: "zIn"},


    {cName: "View @ 100%", cReturn: "z100"},
{cName: "Zoom Out", cReturn: "zOut" },
{cName: "-"}


)


//
if(cChoice == "zIn")
    this.zoom = 200; 
else if (cChoice == "z100")
    this.zoom = 100;
else if(cChoice=="zOut") 
    this.zoom = 40;


Watermarks
Following are two methods for adding watermarks to a 
PDF document—using either the watermark from an 
external file or from text specified in the JavaScript.


Adding a watermark from an external file


Add a watermark from an external PDF file to a selected 
range of pages in the current document.


The following code(for Acrobat 7 or higher) adds a 
watermark image, from an external file, to the first two 
pages of the document. 


this.addWatermarkFromFile({
  cDIPath: "/C/watermark.pdf",
  nSourcePage: 0, // select source doc page 0
  nEnd: 1,
  nHorizAlign: 0,
  nVertAlign: 0,
  nHorizValue: 288,
  nVertValue: -144,
});


N OTE: Because of security restrictions, the above script 
can only be executed in the JavaScript Console or 
in batch mode.


Adding a watermark from text


Add specified text to current document as a watermark.


The following code places the word “Confidential” on all 
pages of the document. This code could be run from the 
JavaScript console.


this.addWatermarkFromText(
"Confidential", 0, font.HelvB, 24, 


    color.red );
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Who should read this document


This document is a tutorial-level guide for users who need to add 
scripting intelligence to PDF documents and forms.


Document contents


This collection of JavaScript snippets provides code samples that 
address a variety of basic tasks commonly faced when trying to 
add JavaScript to enhance PDF forms and documents.


The samples are organized into two main categories:


Forms: For adding intelligence to Acrobat forms.


Documents: For all document operations other than 
those most suited to use in forms.


Within these categories, the samples are organized by their 
functional use rather than by the JavaScript object name, which 
makes it easier to find samples for a given task. For more 
information, see the Developing Acrobat Applications using 
JavaScript. 


Prerequisites


This document is intended for users with little or no experience 
with JavaScript. However, its use will be greatly enhanced if you 
have a basic knowledge of the following:


• The types of events which can trigger JavaScripts actions


• How to use the Acrobat UI to create those actions


• The hierarchy of scripting objects, properties, and methods 
(see JavaScript for Acrobat API Reference).


• The PDF coordinate system used in PDF documents


• How to use the JavaScript Console and Debugger to enter, 
execute, and test scripts you are developing.


For information on the above topics, see Developing Acrobat 
Applications Using JavaScript as well as other documents listed in 
the  Resources  chapter.


Setting JavaScript actions


Adding JavaScript to PDF documents often requires setting 
actions for a variety of field types and events. The chapter 
Creating actions for events gives a brief summary of how to set 
those actions. 


Multiple scripting models


A PDF file can either Acrobat forms and documents, or Adobe 
LiveCycle XML forms. The following table shows the relationship 
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between the various scripting models, the data formats, and 
what tools can be used to create and edit the document. 


N OTE: You can tell if a form you open in a PDF file is an XML 
form because the form tools in the Tools Menu will 
be grayed out.


JavaScript for Acrobat for use in LiveCycle XML forms


JavaScript for Acrobat can also be used in XML forms for 
LiveCycle, but its use is restricted to those objects that do not 
affect form fields or the structure of the form. For example, it can 
be used for tasks such as to open or attach external files, 
manipulate annotations, check the version of the viewing 


application, etc. It cannot be used to change field values, get field 
names, add or remove fields, delete or extract pages, add an 
action to a link, create a template, or change tabbing order. Those 
types of operations must be done using JavaScript for LiveCycle.


For more information see Converting Acrobat JavaScript for Use in 
LiveCycle Designer Forms, available at:


http://partners.adobe.com/public/developer/en/acrobat/sdk/
AcroJS_DesignerJS.pdf


Product Compatibility


Most samples shown in this document are intended for use with 
Acrobat 6.0 or greater, except where noted.


Form type Data 
type Scripting model File 


format
Development /           
    Editing tool


Acrobat FDF • JavaScript for 
Acrobat


PDF Acrobat (with built-in 
JavaScript editor & 
debugger


LiveCycle XML • JavaScript 
(ECMA script) 
for LiveCycle


• JavaScript for 
Acrobata


• FormCalc


a. Only a subset of the Acrobat scripting objects can be used in LiveCycle forms; see 
JavaScript for Acrobat for use in LiveCycle XML forms , below.


PDF


XDPb


b. XDP format is used with LiveCycle forms 


LiveCycle Designer
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Creating actions for events


This section explains how to set the various types of JavaScript 
actions mentioned in this document. 


N OTE: This section covers only the most basic action types. 
For complete information, see Developing Acrobat 
Applications Using JavaScript.


Setting up for JavaScript
Before you can use JavaScript, you must enable it as described in 
Developing Acrobat Applications Using JavaScript.


Executing JavaScript in the JavaScript console


The JavaScript console provides an interface for testing and 
debugging your JavaScript code., or you can use the console as a 
tool to interact with the document or form. You can either add 
intelligence to a PDF document, or you can execute JavaScript 
from the console as a processing tool. For example, you could 
add a new field to selected pages of an existing forms document, 
or add page numbers to a document without them.


From within the Adobe Acrobat application, open the Acrobat 
JavaScript console window by:


• Select Advanced > Document Processing > JavaScript 
Debugger... or...


• Type Ctrl-j     (Windows), or...


• Type Control-j     (Macintosh)


To evaluate or execute JavaScript code from the console:


• Type in the code, highlight it, and press the Enter key on the 
numeric keypad, or Ctrl+Enter on the regular keyboard.


Field actions 
The following briefly describes how to enter custom Field 
JavaScripts for triggers such as: 


• Mouse Up/Down


• Mouse Enter/Exit


• On Focus/Blur


N OTE: The JavaScript for Acrobat API Reference 
recommends using the Mouse Up action rather 
than the Mouse Down action, to avoid potential 
problems.


To create a custom action:


1. Using the object tool, double-click on a field to bring up 
the Field Properties dialog.


2. Select the Actions tab


3. In the Add an Action pane, under Select Action: select a 
trigger type such as Mouse Up, etc.


4. Under Select Action, select Run a JavaScript from the pop-
up menu


5. Click the Add button and enter the script in the script 
editor window that pops up.
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Custom Validation scripts
The following steps will set a custom validation script for a field. 
Custom validation scripts allow you, for example, to examine and 
validate what the user has entered before it is stored.


1. Double click on the field to bring up the Field Properties 
window.


2. Select the Validate tab.


3. Click the “Run custom validation script” radio button.


4. Click the Edit button, and enter the script.


5. Click OK when done.


Custom keystroke scripts
To create a script which can inspect the user’s keystrokes and 
either respond with a warning message or change the keystroke, 
do the following:


1. Bring up the Text Field Properties dialog box.


2. Select the Format tab.


3. Under Select Format Category, select Custom from the 
pop-up menu.


4. Under Custom Keystroke Script, click on the Edit button.


5. A JavaScript Editor window will pop up, into which you 
can enter your custom keystroke script.


Page Actions
Page action scripts allow you to perform actions when a specified 
page is opened or closed. To create a Page action script:


1. Click on the Pages tab on the left side of the document 
viewing window in Acrobat. Page thumbnails will appear.


2. Click on the icon of the page to which you want to add the 
action.


3. Click on the Options pop-up menu at the top of that pane, 
and from the pop-up list select Page Properties.


4. Select the Actions tab.


5. From the Select Trigger pop-up menu, select either Page 
Open or Page Close, as appropriate.


6. In the Select Action pop-up menu, select Run a JavaScript.


7. Click the Add button and enter the script.


8. When done, click OK.


To define a function or a document open action


A document JavaScript executes when the document is opened, 
and can be used to either define a function which can be used 
globally in the document, or to execute an action you want 
performed before the user sees the document displayed.


To define a document JavaScript function, choose: 


Advanced > JavaScript > Document JavaScripts


You can then enter a name for the script and the code you want 
executed, into the resulting dialog box, and then click Close.


Setting JavaScript Actions
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To set document actions


To set a specific document action, choose:


        Advanced > Document Processing > Set Document Actions...


You will get the Document Actions dialog, wherein you can select 
events such as Document Will Close, Document Will Print, 
Document Did Print, etc. Enter the JavaScript action you would 
like to associate with that event and click OK.


To create folder level JavaScript
Folder level JavaScripts are executed by Acrobat when the 
application is first opened. For example, if JavaScript is executed 
to add a menu item to the application, the resulting menu item 
will remain in effect for all documents, as long as the application 
is open.


Folder level JavaScripts are placed in separate files that have a .js 
file extension, and which are stored in either the Acrobat 
Application JavaScripts folder or in the user’s JavaScripts folder. 
These scripts are loaded when the Acrobat application starts 
execution, and are associated with the Event object’s Application 
Initialization (App/Init) Event.


To create folder level JavaScripts, you may use the JavaScript 
Editor, or any text editor and save the resulting file with the .js 
file extension.


Batch level JavaScripts


A batch level JavaScript is a script that can be applied to a 
collection of documents, and operates at the application level. 


To create or edit a batch level JavaScript, click on the Advanced 
menu and choose the Batch Processing... menu item.


Setting JavaScript Actions
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Testing JavaScript code consists of either executing the code in 
the JavaScript console, or using the code in a PDF document. The 
section below briefly explains how to enable the built-in Acrobat 
debugger for JavaScrip; it is followed by some miscellaneous tips 
for using and debugging JavaScript. For more information on 
debugging, see Developing Acrobat Applications Using JavaScript.


Enabling the debugger
In order to make the debugger available for use, you must enable 
both JavaScript and the debugger. Use the Preferences dialog 
box (Ctrl+K) to control the behavior of the JavaScript 
development environment. To enable the debugger, select 
JavaScript from the list on the left in the Preferences dialog and 
make sure the Enable JavaScript debugger option is checked. 
Note that you must restart Acrobat for this option to take effect.


Simple debugging
Though Acrobat Professional has a full-featured JavaScript 
debugger, you can do simple debugging without learning the 
entire debugging process. For simple scripts, you can sometimes 
locate problems by (each described in following sections):


• Testing and/or developing script snippets in the console.


• Inserting console.println()commands to write 
information to the console. 


Testing using the console
The JavaScript console allows you to evaluate single or multiple 
lines of code. There are three ways to evaluate JavaScript code 
while using the interactive console:


• To evaluate a portion of a line of code, highlight the portion 
and press either Enter on the numeric keypad or Ctrl+Enter.


• To evaluate a single line of code, make sure the cursor is 
positioned on that line and press either the Enter key on the 
numeric keypad or press Ctrl+Enter.


• To evaluate multiple lines of code, highlight the lines and 
press either Enter on the numeric keypad or Ctrl+Enter.


In all cases, the result is displayed in the console.


Using the console.println() command


Another way to debug a script is to insert code to print 
information to the JavaScript console. For example, if you want to 
find out how many times execution got through a for loop 
before failing, you could insert the console.println statement 
in the loop like this: 


for (var i=0; i<numPages; i++)
  console.println("i =" + i)


or you can display the value of a variable (in this example, a 
fictitious variable named pageTotal) as follows:


  console.println(“Pages processed so far: ”, 
pageTotal);
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Miscellaneous debugging tips


• When you see “Undefined” displayed after your script 
executes in the console. When testing a script in the 
JavaScript console, if the script executes correctly, the 
message “Undefined” will often appear. The debug 
mechanism is designed to output the return value of a 
function. But if your code is not a function call, there will be 
no returned value, and hence the message “Undefined” is 
displayed after execution.


• Using breakpoints. When you set breakpoints in the 
JavaScript Debugger window, you must close that window 
before you can test the file. It is not necessary to explicitly 
save the script or the file; Acrobat saves it automatically, and 
it will be there when you next open the window, or when 
execution stops at a breakpoint. 


Common development problems and tips


• Security restrictions. If you’re having problems with an 
action attached, for example, to a field or for a Document 
Open event, check the JavaScript for Acrobat API Reference 
to make sure that security restrictions do not limit that 
method to use only in batch mode or from the JavaScript 
console.


• Which scripting model? When you receive a form 
document from someone else, if you open it and the forms 
tools in the menu bars are grayed-out, it means that it is an 


XML-based form, and form field editing cannot be done 
using Acrobat. You must open the document using Adobe 
Designer. Also, only some JavaScript for Acrobat will work in 
a LiveCycle XML form, see Converting Acrobat JavaScript for 
Use in LiveCycle Designer Forms, available at:


http://partners.adobe.com/public/developer/en/acrobat/sdk/
AcroJS_DesignerJS.pdf


For all other JavaScript functions, you must use 
JavaScript for LiveCycle Designer (which is XML-
based).


• Curly quote characters cause errors. If you have cut-and-
pasted code from another document, it is possible that the 
code text has “curly” quote characters ( for example,  ” 
 instead of  "), which will cause an error in execution.


• Useful object properties and methods. Familiarize 
yourself with doc object properties and methods such as: 
  numFields


  numPages


  pageNum


            as well as the doc methods such as:


  getNthFieldName


  getPageNthWord


  getPageNumWords


Those properties and methods are useful for looping 
through multiple objects, pages, fields, or words.



http://partners.adobe.com/public/developer/en/acrobat/sdk/AcroJS_DesignerJS.pdf
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From Adobe


Adobe Acrobat technical notes are available at:


http://partners.adobe.com/public/developer/acrobat/
sdk/index_doc.html#js


Adobe Documents:


JavaScript For Acrobat API Reference


Developing Acrobat Applications Using JavaScript


Acrobat Online Collaboration: Setup and 
     Administration


Acrobat 6.0 Online Training (for ASN members)
http://partners.adobe.com/asn/tech/pdf/training.jsp


Other Resources


General JavaScript:


Core JavaScript 1.5 specification
http://partners.adobe.com/NSjscript/


Flanagan, David, JavaScript, the Definitive Guide 
(Sebastopol, California: O'Reilly, 2002).


JavaScript for Acrobat:


Deubert, John, Extending Acrobat Forms with 
Javascript. Peach Pit Press, 2003 (Written for Acrobat 
5.0, but still useful for newer versions.).


Padova, Ted, Creating Adobe Acrobat Forms,  New York: 
Wiley, 2002. ISBN: 0-7645-3690-7.



http://partners.adobe.com/asn/tech/pdf/training.jsp

http://partners.adobe.com/NSjscript/

http://partners.adobe.com/public/developer/acrobat/sdk/index_doc.html#js
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A


addWatermarkFromFile() 37
addWatermarkFromText() 37
annotations


create an annotation 22
remove an annotation 22


application version number 22


B


batch level JavaScript 42
bookmarks 23


create a new bookmark 23
insert child bookmark 23
remove bookmark 23


C


calculations 9
delay redrawing 9
Turn calculations on/off 9


color
defining a custom color 12


console, JavaScript 40
console.println() 12
custom validation scripts 41


D


date parsing 8
date timestamp 8
dates


Date() 8
display descriptive help text 16
document actions 42
documents


create a new blank document 23
open an existing document 24


prompt user for document to open 24


E


event.target.value 12, 13
event.value 13


F


field properties
alignment 11
background color 11
default value 11
display 11
font 11
font size 11
multiline 11
password 12
required 12
stroke color 12
stroke line width 12


fields
changing field properties 11
check a check box field 12
check before submitting 18
creating new fields programmatically 10
formatting a number 12
hiding existing field based on conditions 13
highlighting a single field 13
highlighting using a function 14
removing zeros from a field 13
set action for multiple fields 18
set an action for a single field 17


folder level JavaScript 42
form submission, checking, and resetting 18
format, custom keystroke script 41
forms


calculations 9
date handling 8


field operations 10
final field checks 18
validation 20


function 41


G


getNthFieldName(i) 17
getting today’s date 9


J


JavaScript console 40
JavaScript function 41


K


keystroke, custom script 41


L


links
add a link to a page 24
link.setAction() 26
remove all links on a page 25
set an action for a link 26


M


Menu operations 26
menus


add a new menu item 26
addMenuItem() 26
app.execMenuItem() 27
app.hideMenuItem() 27
app.listMenuItems() 27
execute menu item 27
hide a menu item 27
list menu items 27


messages/dialogs


 Index
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app.alert() 28
app.beep 28
app.response() 28
beep the user 28
prompt the user for a response 28
simple alert 28


metadata
get document metadata 24


methods
addAnnot() 22
addField() 31
addLink() 25
addMenuItem() 35
addWatermarkFromFile() 37
addWatermarkFromText() 37
AFParseDateEx() 8
app.addMenuItem() 26
app.alert() 28
app.beep 28
app.execMenuItem() 24, 27
app.fs.isFullScreen 36
app.listMenuItems() 27
app.newDoc() 23
app.openDoc() 24
app.popUpMenuEx 37
app.popUpMenuEx() 29, 30
app.response() 28
console.println() 23
Date() 8
getAnnots() 22
getNthTemplate() 32
getOCGs() 31
getPageBox() 25
removeLinks() 25
resetForm() 19
search.query() 34
setAction() 14, 25
setItems() 33


spawnPageFromTemplate() 32
spell.checkWord() 35
util.printd 8


mouse down event 17
mouse enter event 16, 17
mouse exit event 16, 17


N


navigation
add a pop-up menu 29
add navigational arrows to every page 31
adding page numbers 29
ap.popUpMenuEx() 29
app.popUpMenuEx() 30
get page number of current page 29
go to first page 30
go to last page 30
go to next page 30
go to page number 30
go to previous page 30
pop-up menu for page selection 30


O


OCG
getOCGs() 31
hide all OCG objects on current page 32
show all OCG objects on currrent page 31
toggle state of OCG objects 32


OCG (Optional Content Group) 31


P


page actions, creating 41
pages


insert new page 32
insert/delete/replace/extract pages 32


PostScript font name 11


printing
get list of printers as a combo box 33
print current page (no dialog) 33
print list of available printers 33
print selected form pages 16
set field to not print 16


properties
app.plugIns 22
app.viewerVersion 22
ocgArray.state 32
setItems(app.printerNames) 33


R


reset form 19
resetForm() 19
restricting keystrokes 21
rollover help 16


S


search
attachments 34
bookmarks 34
ignoreAccents 34
matchCase 34
matchWholeWord 34
metadata (XMP) 34


searching
a simple find operation 34
search all fields with specified prefix 17
search fields 17
search.query() 34


setAction() 14
spell checking


spell.checkWord() 35
spellcheck a document 34
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T


timing
set countdown timer 35


V


validation 20
validation, custom scripts 41


verify that required entry was made 20
version checking 22
viewing


app.fs.isFullScreen 36
app.popUpMenuEx 37
change zoom value 36
go to fullscreen and start slide show 36
pop-up menus for zooming 37


prompting for a zoom value 36


W


watermarks
adding from an external file 37
adding from text 37





		JavaScript for Forms

		Date handling

		Date timestamp: first time only

		Date Parsing

		Displaying a localized date

		Getting today’s date



		Calculations

		Calculations: Turn calculations on/off

		Delay redrawing of appearance changes



		Field Operations

		Add/Remove a new field programmatically

		Add/Remove fields on multiple pages

		Changing field properties

		Color: defining a custom color

		Check a check box field

		Formatting a number in a form field

		Formatting: removing zeros so field is blank

		Hiding/un-hiding an existing field based on conditions

		Highlighting a single field

		Highlight fields using a function

		Highlighting multiple fields using a for loop

		Locating fields and listing field names

		Printing: Set field to print or not print

		Print selected form pages

		Rollover help

		Display help text



		Search fields

		Search for all fields with a specified prefix

		Set an action for a single field

		Set an action for multiple fields





		Form checking and resetting

		Final field checks

		Check fields before submitting

		Resetting a form





		Validation

		Validate that number is in the correct range

		Verify that required entry was made

		Convert user input to uppercase characters

		Restricting keystrokes to uppercase characters
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		Application Version
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		Get the number of the current page
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		Viewing
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Tool Bar Button





		AddToolbarButton: 

		RemoveToolbarButton: 

		Toolbar_text1: Click the Add Toolbar Button to add a toolbar button of a running man. When you click that item, you will see a message "You have clicked the JavaScript toolbar button".
This sample shows how to add/remove toolbar buttons in Acrobat using the Acrobat JavaScript APIs. The resulting button has warning text below it that tells the user that the added tool is a JavaScript window, as a security measure.  

		Toolbar_text2: This example uses the addToolButton method which  takes an Icon Stream Generic Object which has three properties: a function that returns the stream data, the width, and the height. The stream is a hexadecimal string that represents the alpha, red, green and blue channels. Each four-byte block represents a single pixel.

		Toolbar_text3: Add the running man logo button:

		Toolbar_text4: Remove the running man logo button:










		myButton1: 

		myButton2: 

		myButton3: 

		myButton4: 

		myButton5: 

		myButton6: 

		myButton7: 

		dateField: 

		reset: 

		exec: 

		inputDateField: 

		buttonPDFDate: 

		outputPDFDate: 

		Date_label1: PDF Date Format to JS Date Object

		Date_label2: Convert JS Date Object to PDF Date Format

		Date_label3: Now let’s go the other way. The field below assumes there is a date
object alive from the field above.

		Date: 

		text4: pdfDate = util.printd(0, new Date());

		text5: pdfDate = "D:2004";

		text6: pdfDate = "D:200403";

		text7: pdfDate = "D:20000801145605+07’00’";

		text8: pdfDate = "D:200408041200Z"; (noon GMT)

		text9: pdfDate = "D:199812231952-08’00’";

		text10: pdfDate = "D:199812231952-08’30’";

		text11: var d = pdfDate2oDate( pdfDate )

		text12: Converted date:



		Text13: Try entering data of your choice:   

		Text14: Input PDF Date Format 
(D:YYYYMMDDHHmmSSOHH’mm’)

		ConvertDates_Heading: Converting PDF Dates to JS Date Objects

		ConvertDate_Text0: Select one of the following PDF date formats and click its checkbox to convert that date to a JavaScript date object. 

		ConvertDate_Text1: You can also enter your own date in PDF format (as shown) and then click the button to the right of the input box.
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JavaScript for Acrobat 
Snippet Samples











Doc JS

Sticky Note

Mouse up:

   var echo=this.getField("Text_output");
   echo.value="Viewer type is " + app.viewerType;
   echo.value += "\n" + "Viewer version  is " + app.viewerVersion;
   var p = app.getNthPlugInName(2);
   echo.value += "\n" + "The 3rd plug-in is " + p;

Mouse Enter:

   SetButtonActionAsTextValue( "Button_jsExecute", "Text_js");



Doc JS

Sticky Note

this.getField("Text_output").value="";



Doc JS

Sticky Note

Mouse Up:
   var f = this.getField("Text_js");
   this.resetForm(f);
   f.setFocus();




Doc_JS

Sticky Note

function SetButtonActionAsTextValue( btnFieldName, textFieldName)
{
    var b = this.getField(btnFieldName);
    var js = this.getField(textFieldName).value;
    b.setAction("MouseUp", js);
}







Sticky Note

Mouse up:

var cChoice = app.popUpMenuEx
(
	{cName: "Cover page", bEnabled:false},
	{cName: "-"},
	{cName: "Page 2", cReturn: "2"},
	{cName: "More",
		oSubMenu: [ 
			{cName: "Page 3", cReturn: "3"},
			{cName: "More",
				oSubMenu: [
				{cName:"Page 4", cReturn: "4"},
				{cName:"Page 5", cReturn: "5"}
			    ] 
     }
		]
	},
	{cName: "Last page" },
	{cName: "-"},
	{cName: "Beep On", bMarked:global.bFlag}
)

app.alert("You chose the \"" + cChoice + "\" menu item");
if(!isNaN(parseInt(cChoice)))
    this.pageNum =parseInt(cChoice) - 1; 
else if(cChoice=="Last page") 
    this.pageNum = this.numPages - 1;
else if(cChoice=="Beep On") 
     global.bFlag = ! (global.bFlag);
if(global.bFlag) app.beep(0);  




Sticky Note

Mouse up:

var f = this.getField("PopUp_code");
this.resetForm(f);
f.setFocus();




Sticky Note

function SetButtonActionAsTextValue( btnFieldName, textFieldName)
{
    var b = this.getField(btnFieldName);
    var js = this.getField(textFieldName).value;
    b.setAction("MouseUp", js);
}







Sticky Note

Mouse up:

this.getField("Text_meta.path").value = this.path;
this.getField("Text_meta.filename").value= this.documentFileName;
this.getField("Text_meta.outputText").value=this.metadata;



Sticky Note

Mouse up:

// Reset metadata field:

this.resetForm("Text_meta");








Sticky Note

function SetButtonActionAsTextValue( btnFieldName, textFieldName)
{
    var b = this.getField(btnFieldName);
    var js = this.getField(textFieldName).value;
    b.setAction("MouseUp", js);
}



Sticky Note

Mouse up:

this.pageNum = 0;
// full screen
app.fs.cursor = cursor.visible;
app.fs.defaultTransition = "WipeDown";  // BoxIn, BoxOut
app.fs.timeDelay = 2; // delay 2 seconds
app.fs.useTimer = true; // activate automatic page turning
app.fs.usePageTiming = true; // allow page override
app.fs.clickAdvances = true;
app.fs.escapeExits = true;
app.fs.loop = true;
app.fs.backgroundColor = color.ltGray;


// go 
app.fs.isFullScreen = true;





Sticky Note

Mouse up:

this.resetForm("FullScreen_code");
f.setFocus();









Sticky Note

Mouse up:

// AddLinks
// make every word "Acrobat" into a link to Acrobat Web site

var p=this.pageNum;
var numWords = this.getPageNumWords(p);
for (var i=0; i<numWords; i++)
{
    var ckWord = this.getPageNthWord(p, i, true);
    if ( ckWord == "Acrobat")
    {
	var q = this.getPageNthWordQuads(p, i);
	// convert quads in Default User Space to Rotated
	// User Space used by Links.
	m = (new Matrix2D).fromRotated(this,p);
	mInv = m.invert()
	r = mInv.transform(q)
	r=r.toString()
	r = r.split(",");
	l = addLink(p, [r[4], r[5], r[2], r[3]]);
	l.borderColor = color.red
	l.borderWidth = 1
                    l.setAction("this.getURL('http://www.adobe.com/products/acrobat', false);");
    }
}




Sticky Note

Mouse up:

var b = this.getPageBox("Crop", p);
this.removeLinks(this.pageNum, b);










Sticky Note

Mouse up:

// TTS works on windows only 
if(app.platform != "WIN")
   app.alert("This sample works on Windows only."); 
else {
    var name=this.getField("Speech_name").value;
    var intro=this.getField("Speech_intro").value;


    var str1 = "My name is " + name;
    var str2 = intro;

    if(typeof(tts) != "undefined" && tts.available) {
        tts.qText(str1);
        tts.qText(str2);
        tts.talk();
    }
    else
    {
        var str = "Sorry, Text-To-Speech is not available.";
        app.alert(str);
        app.alert(str1 + "  " + str2);
    }
}








Sticky Note

Mouse up:

// Resetting form restores default value
this.resetForm("DisplayProgress_code");

var f = this.getField("DisplayProgress_code");
f.setFocus();



Sticky Note

Mouse up:

// get thermometer
var numOfSteps = 50;
var t = app.thermometer;
// set
t.duration = numOfSteps;
t.value = 0;
// use timer
var run = app.setInterval("myProcess()", 100);
// stop after 5 minute
var stoprun=app.setTimeOut("endProcess()",5000);

function myProcess()
{
var t = app.thermometer;
if(t.value==0) {
t.begin();
t.value += 1;
}
else
t.value += 1;// set current value
if (t.cancelled)
endProcess();
}

function endProcess()
{
t.end();
app.clearInterval(run);
}



Sticky Note

function SetButtonActionAsTextValue( btnFieldName, textFieldName)
{
    var b = this.getField(btnFieldName);
    var js = this.getField(textFieldName).value;
    b.setAction("MouseUp", js);
}







Sticky Note


function CalculateAction()
{
    var display = this.getField("displayText");

    switch(global.calculatorLastAction)
    {
       case "+":
           display.value = global.calculatorLastDisplay 
                                                                                + display.value;
            break;
       case "-":
            display.value = global.calculatorLastDisplay 
                                                                                - display.value;
             break;
       case "*":
            display.value = global.calculatorLastDisplay 
                                                                                * display.value;
            break;
        case "/":
            display.value = global.calculatorLastDisplay 
                                                                                /  display.value;
             break;
        }
}



Sticky Note

function DoAction(action)
{
    var display = this.getField("displayText");

    //if(action == "=")
       CalculateAction();
  //  else
    {
     //   switch(
    }
    global.calculatorLastDisplay = display.value;
    global.newValue = true;
    global.calculatorLastAction = action;
}



Sticky Note

function IncrementDisplay(value)
{
    var display = this.getField("displayText");

    if(global.newValue == false) {
	if(display.valueAsString == "0" && value != ".")
		display.value = value;
		else {
		if(display.valueAsString.indexOf(".") == -1 || ((display.valueAsString.indexOf(".") != -1) && value != "."))
				display.value = display.valueAsString + value;
		}
	}
    else
    {
		if(value == ".")
			display.value = "0" + value;
		else
			display.value = value;
        global.newValue = false;
    }
}







Sticky Note

var C1 = this.getField("Combine.1");
var C2 = this.getField("Combine.2");
var F1 = this.getField("Forms.1");
var F2 = this.getField("Forms.2");
var R1 = this.getField("Reviews.1");
var R2 = this.getField("Reviews.2");

C1.hidden = false;
C2.hidden = false;
F1.hidden = true;
F2.hidden = true;
R1.hidden = true;
R2.hidden = true;



Sticky Note

var C1 = this.getField("Combine.1");
var C2 = this.getField("Combine.2");
var F1 = this.getField("Forms.1");
var F2 = this.getField("Forms.2");
var R1 = this.getField("Reviews.1");
var R2 = this.getField("Reviews.2");

C1.hidden = true;
C2.hidden = true;
F1.hidden = false;
F2.hidden = false;
R1.hidden = true;
R2.hidden = true;



Sticky Note

var C1 = this.getField("Combine.1");
var C2 = this.getField("Combine.2");
var F1 = this.getField("Forms.1");
var F2 = this.getField("Forms.2");
var R1 = this.getField("Reviews.1");
var R2 = this.getField("Reviews.2");

C1.hidden = true;
C2.hidden = true;
F1.hidden = true;
F2.hidden = true;
R1.hidden = false;
R2.hidden = false;
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Acrobat JavaScript
— Core JavaScript + Acrobat objects


JavaScript Object : properties, methods( )
— Doc : metadata, addLink (nPage, oRect)


JavaScript Location
— Inside PDF �les


• Doc level script
• Action of �elds, links, bookmarks, Doc, Pages


— Outside PDF �les
• Folder level, Console, Batch


Accessibility varies with
— Location, Viewer type, Version, Security, etc


VB JavaScript Object



Sticky Note

Mouse up:

this.getField("hide1").hidden = false;
this.getField("hide2").hidden = false;
this.getField("hide3").hidden = false;
this.getField("hide4").hidden = false;
this.getField("hide5").hidden = false;





Sticky Note

Mouse up:

if(this.getField("hide1").hidden==false)
    this.getField("hide1").hidden=true;
else if(this.getField("hide2").hidden==false)
    this.getField("hide2").hidden=true;
else if(this.getField("hide3").hidden==false)
    this.getField("hide3").hidden=true;
else if(this.getField("hide4").hidden==false)
    this.getField("hide4").hidden=true;
else if(this.getField("hide5").hidden==false)
    this.getField("hide5").hidden=true;
//this.getField("hide1").setFocus();









Sticky Note

function SetButtonActionAsTextValue( btnFieldName, textFieldName)
{
    var b = this.getField(btnFieldName);
    var js = this.getField(textFieldName).value;
    b.setAction("MouseUp", js);
}



Sticky Note

this.getField("ComboBox_printers").setItems(app.printerNames);



Sticky Note

// Print this page

// get the printParams object of the default printer
var pp = this.getPrintParams();
// print this file 
// if print another file, specify pp.fileName = .....
// print this page
pp.firstPage = this.pageNum;
pp.lastPage = this.pageNum;
// set some properties
pp.interactive = pp.constants.interactionLevel.automatic;
pp.colorOverride = pp.constants.colorOverrides.auto;
// use the printer selected
var aPrinter = this.getField("ComboBox_printers").valueAsString;
if(aPrinter!=null) pp.printerName=aPrinter;

// print
this.print(pp);



Sticky Note

// Reset the Print_code field
// to default value

this.resetForm("Print_code");








odonnell

Sticky Note


// get our template
var template1 = getTemplate("FramePage");

// based on the template, append a new page before this page. rename fields.

var newPageNum = this.pageNum;
template1.spawn(this.pageNum, true, false);

// make a new bookmark
var bkName = this.getField("Form_bmName").value;
if(bkName =="" )    bkName = "New Page";

// make a bookmark in top level 
var numChild = bookmarkRoot.children.length - 1;
bookmarkRoot.createChild(bkName, "this.pageNum = " + newPageNum,  numChild );

// note that the new bookmark would point to a page by page number, so if the user makes any change in  bookmarks or pages, the bookmark action won't function correctly. A more flexible approach is available, but it needs complex code.  

// go to the new page
this.pageNum = newPageNum;





		Catalog

		Execute a Script

		Create a Pop-up Menu

		View Metadata

		Set Full Screen Mode

		Add Links to Text

		Convert Text to Speech

		Display a Progress Bar

		Use a Calculator

		Show/Hide Text

		Control Conditional Text

		Locate Printers and Print

		Add a New Page



		Text_js: var echo=this.getField("Text_output");
echo.value="Viewer type is " + app.viewerType;
echo.value += "\n" + "Viewer version  is " + app.viewerVersion;
var p = app.getNthPlugInName(2);
echo.value += "\n" + "The 3rd plug-in is " + p;

		Text_output: 

		Button_outputClear: 

		Button_jsReset: 

		Button_jsExecute: 

		Button_GoPopup: 

		Button_popupReset: 

		PopUp_Title: Create a Pop-up Menu

		Metadata_title: View Metadata

		Metadata_text1: Enter the file name of a document and its path and click Go, or use the default which is this document. The document's metadata will be displayed in the window below. You can clear the displayed text by clicking Clear. The document metadata is a property of the 

		Metadata_text2: JavaScript Doc object.  Note that the output field is set to use an 8-point font size, so some of the metadata may not fit in the field (but you can scroll down).

This example does not work with Adobe Reader.

		Metadata_filenameTitle: File name

		Metadata_pathTitle: Path

		Metadata_metadataTitle: Metadata

		Button_meta: 

		go: 



		Button_metaClear: 

		Text_meta: 

		filename: JSSnippetsNew.pdf

		path: /RaysMacBookPro/Users/jtchen/Desktop/JavaScript Samples/Embedded JavaScript/JSSnippetsNew.pdf

		outputText: <x:xmpmeta xmlns:x="adobe:ns:meta/" x:xmptk="Adobe XMP Core 4.2.1-c041 52.342996, 2008/05/07-21:37:19        ">
 <rdf:RDF xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#">
  <rdf:Description rdf:about=""
    xmlns:xmp="http://ns.adobe.com/xap/1.0/"
    xmlns:dc="http://purl.org/dc/elements/1.1/"
    xmlns:pdf="http://ns.adobe.com/pdf/1.3/"
    xmlns:xmpMM="http://ns.adobe.com/xap/1.0/mm/"
    xmlns:adhocwf="http://ns.adobe.com/AcrobatAdhocWorkflow/1.0/"
   xmp:CreatorTool="PScript5.dll Version 5.2.2"
   xmp:ModifyDate="2008-05-16T14:48:01-07:00"
   xmp:CreateDate="2007-11-14T10:57:50-08:00"
   xmp:MetadataDate="2008-05-16T14:48:01-07:00"
   dc:format="application/pdf"
   pdf:Producer="Acrobat Distiller 8.1.0 (Windows)"
   pdf:Keywords=""
   xmpMM:DocumentID="uuid:cdd5d1cc-3c17-4b34-8217-bf702483820c"
   xmpMM:InstanceID="uuid:fcda3244-4b91-1249-9458-865515ac80a9"
   adhocwf:state="1"
   adhocwf:version="1.1">
   <dc:title>
    <rdf:Alt>
     <rdf:li xml:lang="x-default">JavaScript for Acrobat Snippet Samples</rdf:li>
    </rdf:Alt>
   </dc:title>
   <dc:creator>
    <rdf:Seq>
     <rdf:li>Adobe Developer Technologies</rdf:li>
    </rdf:Seq>
   </dc:creator>
  </rdf:Description>
 </rdf:RDF>
</x:xmpmeta>




		Button_Gofs: 

		Button_fsReset: 

		FullScreen_title: Set Full Screen Mode

		FullScreen_text1: Click the Go button to view this document in full screen mode.  The script will cause the document to display in full screen mode, and it sets the display to automatically turn the page every 2 seconds. Press Esc to quit full screen mode.



		FullScreen_text2: You can edit the  code to try various options, and then execute the new code by the Go button again. Click the Reset Code button to restore the default code.

Note: This example uses the SetButtonActionAsTextValue function as explained in the Foreword. 

		AddLinks_text1: Click on the buttons below to add and remove links for the sample text below the buttons. The Add button will add a link to Adobe.com for every occurance of the word “Acrobat” on this page.
The JavaScript methods Doc.AddLink(), Doc.RemoveLinks(), Link.SetAction() and others are used in the code for the actions attached to the buttons. Also, note how the script draws a rectangle around the selected words.

		AddLinks_text2: Clicking the Add Links button causes Acrobat to download the referenced page and display it as a PDF document in a separate window. A download progress window will be displayed showing the progress for the files being downloaded.

This example does not work with Adobe Reader.

		AddLinks_title: Add Links to Text

		Btn_addLinks: 

		Btn_removeLinks: 

		AddLinks_sampleText: Adobe Acrobat® consists of a suite of applications and utilities for creating, modifying, indexing, searching, displaying, and manipulating PDF (Portable Document Format) files.
Viewer applications:
• Acrobat Reader for viewing, navigating, and printing PDF documents.             
• Acrobat for adding navigational links, annotations, and security options,
   in addition to the functionality provided by Acrobat Reader.

Tools for creating PDF files:
• Acrobat Distiller® for creating PDF documents from PostScript® files
  from your favorite PostScript® applications (including desktop
  publishing software).
• Acrobat PDFWriter for creating PDF files from your favorite business
  applications using only the Print command.
  Other applications:




		AddLinks_sampleText2: • Acrobat Capture® plug-in with OCR (Optical Character Recognition
  for creating text-searchable PDF documents from scanned paper
  originals. 

What Is the Acrobat SDK?
The Acrobat SDK is a “toolbox” that helps you develop software that
interacts with Acrobat technology. The SDK contains header files, type
libraries, simple utilities, sample code, and documentation.
Some of the things you can do with the SDK are:
• Write plug-ins that extend the functionality of the Acrobat viewers
To do this, you use the Acrobat Core API (see “Acrobat Core API” on
page 9.) You may also use the functionality of other Acrobat plugins;
see “Extended APIs For Plug-ins” on page 11.
• Write external applications that communicate with and control
Acrobat. To do this, you use the interapplication communication
(IAC) APIs.

		AddLinks_Label: Sample Text:

		FullScreen_code: this.pageNum = 0;
// full screen
app.fs.cursor = cursor.visible;
app.fs.defaultTransition = "WipeDown"; // BoxIn, BoxOut
app.fs.timeDelay = 2; // delay 2 seconds
app.fs.useTimer = true; // activate automatic page turning
app.fs.usePageTiming = true; // allow page override
app.fs.clickAdvances = true;
app.fs.escapeExits = true;
app.fs.loop = true;
app.fs.backgroundColor = color.ltGray;
// go
app.fs.isFullScreen = true;

		DisplayProgress_title: Display a Progress Bar

		DisplayProgress_text1: Click the Go button to see a progress bar at the bottom of the Acrobat frame window. The code uses the Thermometer JavaScript object and a timer function; the process will last for 5 seconds.


		DisplayProgress_text2: Note: This example uses the SetButtonActionAsTextValue function as explained in the Foreword.


		DisplayProgress_code: // get thermometer
var numOfSteps = 50;
var t = app.thermometer;
// set
t.duration = numOfSteps;
t.value = 0;
// use timer
var run = app.setInterval("myProcess()", 100);
// stop after 5 minute
var stoprun=app.setTimeOut("endProcess()",5000);

function myProcess()
{
var t = app.thermometer;
if(t.value==0) {
t.begin();
t.value += 1;
}
else
t.value += 1;// set current value
if (t.cancelled)
endProcess();
}

function endProcess()
{
t.end();
app.clearInterval(run);
}

		Button_GoThermometer: 

		Button_themReset: 

		button_speak: 

		applause: Applause

		Speach_nameLabel: Type your name:

		Speech_name: Tom

		Speach_introLabel: Introduce yourself:

		Speech_intro: I am a developer from New York

		Print_title: Locate Printers and Print

		Print_text1: First click the Show printers button to get the available printers and display them in the combo box. Select a printer, then click the Print button. 
The printers should be properly set up for your system. This is only sample code, and you may need to modify the 

		Print_text2: printing parameters if they do not work on your system; see the JavaScript for Acrobat JavaScript API Reference.

Note: This example uses the SetButtonActionAsTextValue function as explained in the Foreward.

		Button_print: 

		Button_printReset: 

		ComboBox_printers: []

		Label_printers: Select a printer:

		Button_getPrinters: 

		Print_code: // get the printParams object of the default printer
var pp = this.getPrintParams();
// print this file 
// if print another file, specify pp.fileName = .....
// print this page
pp.firstPage = this.pageNum;
pp.lastPage = this.pageNum;
// set some properties
pp.interactive = pp.constants.interactionLevel.automatic;
pp.colorOverride = pp.constants.colorOverrides.auto;
// use the printer selected
var aPrinter = this.getField("ComboBox_printers").valueAsString;
if(aPrinter!=null) pp.printerName=aPrinter;

// print
this.print(pp);


		Calculator_title: Use a Calculator

		Calculator_text1: Click the keys on the keyboard below to use the JavaScript calculator.

The calculator uses three document-level functions: IncrementDisplay, CalculateAction, and DoAction.

		Calculator_text2: Clicking a numeric key calls the IncrementDisplay function to add that key's number to the end of the display string. Function keys (such as add, subtract, etc.) result in calls to the DoAction function which decides which action to take.

		displayText: 0

		equals: 

		decimal: 

		zero: 

		three: 

		two: 

		one: 

		four: 

		five: 

		six: 

		add: 

		nine: 

		eight: 

		seven: 

		minus: 

		divide: 

		clearAll: 

		multiply: 

		Speech_title: Convert Text to Speech

		ConditionalText_title: Control Conditional Text

		ConditionalText_text1: Click "Hide Bullet Items", then click "Show Bullet Item up to five times to reveal the hidden text. 

Text in form fields can be easily hidden and unhidden using the ".hidden" property of the field. However, the bullet items below are document text, not text in form fields.

		ConditionalText_text2: The document text is hidden by covering them with blank, opaque, form fields, which the script manipulates using the hidden property.  This method is not very elegant, but is included to illustrate a possible use of scripting.

		hide1: 

		hide2: 

		hide3: 

		hide5: 

		hide4: 

		ConditionalText_SampleHead: What is JavaScript for Acrobat?

		PopUp_code: var cChoice = app.popUpMenuEx
(
	{cName: "Cover page", bEnabled:false},
	{cName: "-"},
	{cName: "Page 2", cReturn: "2"},
	{cName: "More",
		oSubMenu: [ 
			{cName: "Page 3", cReturn: "3"},
			{cName: "More",
				oSubMenu: [
				{cName:"Page 4", cReturn: "4"},
				{cName:"Page 5", cReturn: "5"}
			    ] 
     }
		]
	},
	{cName: "Last page" },
	{cName: "-"},
	{cName: "Beep On", bMarked:global.bFlag}
)

//app.alert("You chose the \"" + cChoice + "\" menu item");
if(!isNaN(parseInt(cChoice)))
    this.pageNum =parseInt(cChoice) - 1; 
else if(cChoice=="Last page") 
    this.pageNum = this.numPages - 1;
else if(cChoice=="Beep On") 
     global.bFlag = ! (global.bFlag);
if(global.bFlag) app.beep(0);  


		PopUp_text1: Click the Create Menu button to create a pop-up menu. You can then select a menu item to navigate to another page, and use the return-to-previous-view button in the Acrobat menu bar to return to this page. You will be prompted with an alert message showing which menu option you chose.


		PopUp_text2: You can also modify the code below to try other parameters, and then click Create Menu. You can return to the original code by clicking Reset Code.

This example uses the app.popUpMenuEx method to add the menus and set the action for each choice.

		Execute_text1: Click the Execute button to execute the
script shown below in the box below. The type of viewer application, its version number, and the third plug-in loaded (if any) will be displayed in the Text_output field. You can edit the code to try other variations. To do that, you should click Clear to erase any previous output, and then Execute to try the new code.


		Execute_text2: Clicking Reset will reset the code to in Text_js to its original default value.

Note: See the Foreward for an explanation about the script used to enable execution of the editable code in the Text_js field. 

		Speech_text1: Type in your name and add some text to introduce yourself, and then click the Speak Out button to hear the text converted to speech.
This example uses the JavaScript TTS object which translate text into speech. That object is currently a Windows-only feature and requires that the Microsoft Text-to-Speech engine be installed in the operating system.

		Speech_text2: This example only works in Windows, and does not work with Adobe Reader.

		TOC_foreward: Foreword

		TOC_col1: Execute a Script

Create a Pop-up Menu

View Metadata

Set Full Screen Mode

Add Links to Text

Convert Text to Speech



		TOC_col2: Display a Progress Bar

Use a Calculator

Show/Hide Text

Control Conditional Text

Locate Printers and Print

Add a Page from a Template

		JSCover_title: A collection of interactive samples that demonstrate JavaScript for
Acrobat being used in PDF forms and documents. 

		Combine: 

		2: 
Share files with virtually anyone, regardless of software or platform. 

Combine multiple files into a single PDF document. 

Easily organize and place files in the correct viewing order. 

Present information in a polished, professional manner. 

Share files immediately through e-mail rather than making your recipient wait hours or even days to receive a package by courier or mail. 

Archive information in PDF/A, a format that provides the ability to open and view files for years to come. 


		1: Key Benefits for Combining and Sharing Documents:



		Forms: 

		2: Increase productivity and reduce errors. 

Design an electronic form from scratch, leverage an existing form template, or convert a static PDF form to a fillable form. 

Enable anyone with free Adobe Reader® software to type information directly into an Adobe PDF form or save it locally to work offline at a later date. 

Export all information from a filled form into a spreadsheet for analysis or import into a data system. 


		1: Key Benefits for Forms:



		Reviews: 

		2: Enable anyone with free Adobe Reader® software to participate in reviews. 

Use intuitive commenting and markup tools to articulate feedback. 

See and respond to other reviewers' feedback for better collaboration. 

Easily sort comments by type, page, author, date, and checkmark status. 

Use digital signatures to verify authenticity and obtain approvals.

		1: Key Benefits for Document Reviews:



		Text5: Acrobat Solutions: 
What do you want to do?

		Radio ButtonSH: 2

		Show: 

		text1: Select one of the radio buttons below to see a set of key benefits for each item. 
In this example, each radio button toggles the 'hidden' property for the field. 

		text2: Only one button can be set at one time because the three buttons have the same name.

		text6: Combine and share documents?

		text7: Create an electronic form?

		text8: Streamline document reviews



		Execute_title: Execute a Script

		Text8: Document JavaScript:

		Calc_text1: Document JavaScripts:

		Calc_text2: IncrementDisplay

CalculateAction

DoAction

		Forword_title: Foreword

		Foreward_text1: This document provides interactive examples of using JavaScript for Acrobat in PDF forms and documents. Each example demonstrates actions that can be triggered by user interaction, has an explanation of how the sample works, and shows the code used in the scripts. In many cases you can edit the code to try variations and different parameters, and then execute the edited script.
 
About the samples:

* Most buttons and fields on each page have a text       annotation next to them which shows the code used for the action of that button or field. 

* Form fields referenced by the code are labelled with their   name below the right corner of the field

* Document JavaScript is provided in a text annotation, and can be viewed using a "mouse-over". 


You can click the Select Object tool and then select and copy fields (including buttons) or groups of fields, and paste them in another document. The scripts attached to the fields are also copied and will work in the new document. If pasting fields from this document into an another PDF form, be careful that field names and variables/global variables do not conflict. If a script in the example references a document-level JavaScript, be careful to also copy that to the new document.


		Foreward_text2: You can also copy and paste code from the editable code in some examples, and from the annotations showing the code for each button or for document-level JavaScript. 



Several examples show code in a window which you can edit to try various parameters.  After editing the code, when you tab out, or click in another field (called a "blur" event), which calls the document-level function  SetButtonActionAsTextValue. That function sets the text in the window as the action triggered when the chosen event occurs, such as Mouse Up, etc. Click the Reset button to return to the original default code for that field.


Due to the functionality restriction restrictions in Reader, the following samples will not work in Adobe Reader: 
    Metadata             Text-To-Speech
    Add links              Create a new page



The last example in this document allows you to add new pages to this document, using the template .... (also creates a bookmark for it). You can use it to try new scripts, or to collect your favorite code snippets for later use.





		Foreward_text3: Using Code from the Examples

		Foreward_text5: Samples Not Supported by Reader

		Add_title: Add a New Page from a Template

		Add_text: Add a new page and 
make a bookmark 
using the following name:

		Form_bmName: 

		Form_button_newpage: 

		Text0: 

		Add_text1: The button below will add a new page to this document using a template page stored in the PDF, and make a bookmark for that page (the page will be inserted before this page). 
This document contains a hidden template which has  three text fields such as the title above, and these two columns for descriptions. 

		Add_text2: Those fields on the new page will have a gray border to make them visible, but you can delete the fields or change properties as desired.



This example does not work with Adobe Reader.

		Template_text1: 

		Template_text2: 

		Show_text0: Show/Hide Text

		Foreward_text6: Add New Pages

		FullScreen_docJS: Document JavaScript: 

		ConditionalText_HideAll: 

		ConditionalText_Show: 

		Foreward_text4: Editable Code Fields and How They Work
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		Layers_title: Control Layers

		Layers_text1: Click the buttons to get setttings, show or hide layers,  or to toggle the watermark. Clicking the Toggle Layers button will hide or show one layer at a time.

Click the Layers icon (two partly overlapping squares, below the pages and bookmark icons) to the left of the document page to show the layers and be able to change their state through the UI.

		Layers_text2: When you click Get Settings, notice that the watermark is in the OCG array; it is located by testing for its name. The other elements on this page are not contained in layers so are not affected by the script.


		Layers_Button13: 

		Layers_Button14: 

		Layers_Button15: 

		Button5: 

		Button6: 

		OCG_settings: 

		Layers_ClearButton: 

		Layers_Label1: Settings:








special

Name



special

Address



special

Phone



special

Sex



special

Male



special

Female



special

Line



special

Line







 EmbeddingFormData.pdf -  Acrobat SDK sample  
 
 This JavaScript sample demonstrates that a searchable database can be embedded inside a PDF 
form document.  In the code, the Doc's data object methods are mainly used to create, embed, import, and 
export multiple sets of form data; but bookmarks, fields, and many other objects and methods are also 
extensively used.  
 Some form data are already embedded in the PDF, and you can click the form data entry under 
the Form Data List bookmark to retrieve the data. 
             The Reset button will empty all form fields. 
 To add a set of new data, first fill in the form manually or import data from a FDF file, then press 
the Embed Form Data button and input a name. A new bookmark for the data entry will be added.  
 You can modify an existing data set by changing some data fields and pressing the Embed  button. 
When you input the name of an existing data set, you overwrite that data entry. 
 To delete a data set, just delete the data entry bookmark. Since the data object associated with the 
entry exists after that, you also need to make your confirmation to delete the data object when you save 
the PDF form. 
 To find certain form data, enter your search values in the fields, then press the search button. 
The Search criteria bookmark and the search results will be shown under the form data search bookmark. 
You can click them to see the data. 
 The code in this sample is located inside a PDF document, but it can be modified to be  
folder-level code to work with other PDF form files. This is a sample, however, not a well-developed tool. 
Many improvements are left to the developer if they want to use the functionality in the real world.  





		Form Data Search

		Search Criteria

		Andy Holman





		Form Data List

		John Daly

		Lucia Johnson

		Andy Holman

		Bob Kern

		Amy London

		Nancy Miller







sdkFormData|Amy London|20040917144518|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|333 First St.^Off^Amy London^890-2317^Yes^F^Yes^Off^pediatrics




sdkFormData|Andy Holman|20040917144338|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|555 Broadway^Yes^Andy Holman^987-1234^Yes^M^Off^Yes^internal medicine




sdkFormData|Bob Kern|20040917144429|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|512 Adams^Off^Bob Kern^567-0222^Off^M^Off^Yes^family practice




sdkFormData|John Daly|20040917144035|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|123 main st.^Off^John Daly^222-6666^Off^M^Yes^Yes^family practice




sdkFormData|Lucia Johnson|20040917144240|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|333 South^Yes^Lucia Johnson^123-4567^Yes^F^Off^Off^general practice




sdkFormData|Nancy Miller|20040917144606|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|1234 West^Off^Nancy Miller^404-5503^Yes^F^Off^Off^internal medicine




sdkFormData|Search Criteria|20041004164917|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|^Off^^^Yes^M^Yes^Off^




sdkFormData|Search Criteria|20080519100545|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|^Off^John^^Off^Off^Off^Off^




sdkFormData|Search Criteria|20080519100739|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|^Off^John^^Off^Off^Off^Off^




sdkFormData|Search Criteria|20080519100859|Address^Arts^Name^Phone^Reading^Sex^Sports^Travel^specialty|^Off^ndy^^Off^Off^Off^Off^


		Name: 

		Address: 

		Phone: 

		Sex: Off

		Sports: Off

		Arts: Off

		Reading: Off

		Travel: Off

		btn_embed: 

		btn_reset: 

		Text1: Specialty

		Text2: Insurance

		Text3: Golden Choice

		Text4: Open Choices

		Text5: USAccess

		Text6: Golden Medicare

		Text7: Doctor Information

		specialty: 

		btn_search: 

		btn_help: 

		btn_back: 







	/*********************************************************************



 ADOBE SYSTEMS INCORPORATED

 Copyright 1998-2008 Adobe Systems Incorporated

 All rights reserved.



 NOTICE: Adobe permits you to use, modify, and distribute this file

 in accordance with the terms of the Adobe license agreement

 accompanying it. If you have received this file from a source other

 than Adobe, then your use, modification, or distribution of it

 requires the prior written permission of Adobe.



 ---------------------------------------------------------------------



 sdkAddSignature.js



 - Folder level Acrobat JavaScript file.



*********************************************************************/



/*

 * sdkAddSignature.js

 * 

 * 

 * Folder Javascript Created by Acrobat SDK.

 * This JavaScript sample shows you can programmatically sign a PDF document using

 * your digital ID file. 

 * 

 * As a sample, this file has included all the digital signature information

 * except the path and password for the digital ID file to be used.

 * When you are ready to sign a PDF, click the newly added "Add My Signature" 

 * menu item under the Edit>Acrobat SDK JavaScript menu. 

 * 

 * After you input the platform independent path and 

 * the password through a dialog, the program will create a digital

 * signature field in the top-left corner, and sign it with your data. The path 

 * and password are valid in a Acrobat session, so you can continue to sign more 

 * documents in the session without the input dialogs.

 * If you change the code to specify the path and password for the digital ID 

 * file to be used in this file, then when you click the menu item, the program will 

 * go automatically to sign PDFs without UI. 

 * 

 * Using the function SetUserPassword() and function SetUserDigitalIDPath() in this 

 * folder JavaScript code, you can call the JavaScript to quietly sign a PDF from other 

 * JavaScript code, or from a plug-in or IAC VB or VC program through function 

 * ExecuteThisScript( ). The VB and C Sample code is attached in end of this file.

 * 

 * A digital signature file ( DrTest.pfx ) is provided with the sample for your test

 * To use it, put it in a folder, and specify the proper DIpath ( e.g. /C/DrTest.pfx ).

 * Its password is "testpassword". 

 */



/*

 * Use of an object to emulate a unique namespace.

 *

 * Object literals act like global variables

 * defined within this particular namespace.

 */

if (typeof ACROSDK == "undefined")

	var ACROSDK = {};

	

/* 

 * password to use the digital signature

 *

 * to test the sample without user input, specify:

 * ACROSDK.sigUserPwd = "testpassword";

 */

ACROSDK.sigUserPwd = "UNKNOWN";



/* 

 * path to the digital signature file

 *

 * to test the sample without user input, specify:

 * ACROSDK.sigDigitalIDPath = "/C/DrTest.pfx";

 */

ACROSDK.sigDigitalIDPath = "UNKNOWN";



// other variables the user can modify 

ACROSDK.sigHandlerName = "Adobe.PPKLite";

ACROSDK.sigFieldname = "sdkSignatureTest";

ACROSDK.sigReason = "I want to test my digital signature program.";

ACROSDK.sigLocation = "San Jose, CA";

ACROSDK.sigContactInfo = "sendme@testinc.com";



if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

		cName:"ACROSDK:JSSubMenu", 

		cUser: "Acrobat SDK JavaScript", 

		cParent: "Edit", 

		nPos: 0

	});

}



// Add a menu item for AddSignature

app.addMenuItem( { 

	cName: "ACROSDK:AddSignature", 

	cUser: "Add My Signature", 

	cParent: "ACROSDK:JSSubMenu", 

   cEnable: "event.rc = (event.target != null);",

   cExec: "AddSignature(event.target)"    

});





/**

 * main function

 */ 

function AddSignature(doc)

{

	// if ACROSDK.sigDigitalIDPath is not spcified, ask for user input

	if(ACROSDK.sigDigitalIDPath == "UNKNOWN"){

		var cResponse = app.response({

				cQuestion: "Input your digital ID path:",

				cTitle: "Digital Signature",

				cDefault: "/C/DrTest.pfx",

		});

		

		if ( cResponse == null) {

			app.alert("No input.");

			return;

		}

		else

			SetUserDigitalIDPath(cResponse);

	}

		

	// if ACROSDK.sigUserPwd is not spcified, ask for user input

	if(ACROSDK.sigUserPwd == "UNKNOWN"){

		var cResponse = app.response({

				cQuestion: "Input your password:",

				cTitle: "Digital Signature",

				cDefault:  "testpassword",

		});

		

		if ( cResponse == null) {

			app.alert("No input.");

			return

		}

		else

			SetUserPassword(cResponse);

	}



	// create a new signature field

	var signatureField = AddSignatureField(doc);



	// sign it

	if(signatureField)	Sign(signatureField, ACROSDK.sigHandlerName);

}







/**

 * create a signature field in the upper left conner with name of ACROSDK.sigFieldname

 */

function AddSignatureField(doc)

{

	var inch=72;

	var aRect = doc.getPageBox( {nPage: 0} );

	aRect[0] += 0.5*inch; // from upper left hand corner of page.

	aRect[2] = aRect[0]+2*inch; // Make it 2 inch wide

	aRect[1] -= 0.5*inch;

	aRect[3] = aRect[1] - 0.5*inch; // and 0.5 inch high



	var sigField = null;

	try {

		sigField = doc.addField(ACROSDK.sigFieldname, "signature", 0, aRect );

	} catch (e) {

		console.println("An error occurred: " + e);

	}



	return sigField;

}



/**

 * define the Sign function as a privileged function

 */ 

Sign = app.trustedFunction (

    function( sigField, DigSigHandlerName )

	{

	  try {

		 app.beginPriv();

		var myEngine = security.getHandler(DigSigHandlerName); 

		myEngine.login( ACROSDK.sigUserPwd, ACROSDK.sigDigitalIDPath); 

		sigField.signatureSign({oSig: myEngine, 

								bUI: false,

								oInfo: { password: ACROSDK.sigUserPwd, 

										reason: ACROSDK.sigReason,

										location: ACROSDK.sigLocation,

										contactInfo: ACROSDK.sigContactInfo}

								});

		app.endPriv

	  } catch (e) {

			console.println("An error occurred: " + e);

	  }

	}

);



/** 

 * set a correct password for using the signature, so you can quietly sign a doc.

 */

function SetUserPassword(pwd)

{

	ACROSDK.sigUserPwd = pwd;

}



/** 

 * set path to the digital signature file

 */

function SetUserDigitalIDPath(idPath)

{

	ACROSDK.sigDigitalIDPath = idPath;

}



/*********************************************************************

	VB code in an Acrobat IAC program

	to sign a PDF quietly ( no Acrobat running on screen ),

  using the JS methods in this file

 *********************************************************************

	' .........

	' At this point, a PDF file has been opened, but Acrobat may be hidden. 

		

    ' get acrobat form object

    Dim formApp As AFORMAUTLib.AFormApp

    Set formApp = CreateObject("AFormAut.App")

        

    ' access some object property in objects inside AcroForm.

    Dim fields As AFORMAUTLib.fields

    Set fields = formApp.fields

    

    ' One way to use a JavaScript code in VB is through fields' method ExecuteThisJavascript.

    'Dim nVersion As Integer

    'nVersion = fields.ExecuteThisJavascript("event.value = app.viewerVersion;")

    'MsgBox "The Acrobat Viewer Version is " & nVersion

    

    'Sign the document

    Dim menuItem As String

    Dim digitalIDPwd As String

    Dim digitalIDPath As String

    

    digitalIDPwd = "testpassword"

    digitalIDPath = "/C/DrTest.pfx"

    menuItem = "ADBESDK:AddSignature"

    

    Dim jsCode As String

    Dim jsRc As Boolean

    jsCode = "SetUserPassword(" + "'" + digitalIDPwd + "'); SetUserDigitalIDPath(" + "'" + digitalIDPath + "');" + "app.execMenuItem(" + "'" + menuItem + "');"

    

    ' Execute JS code to sign doc

    fields.ExecuteThisJavascript (jsCode)

    

    'save & close

    AVDoc.Close (True)





	' .........

*********************************************************************/    



/*********************************************************************

	C code in an Acrobat plug-in

	to sign a PDF quietly using the JS methods in this file

 *********************************************************************

ASBool MyCallJS(PDDoc pdDoc)

{

	if(!pdDoc) return false;



	char jsScript[512];

	char* pwd="testpassword";

	char* digitalIDPath = "/C/DrTest.pfx";

	char* menuItem = "ADBESDK:AddSignature";



	sprintf(jsScript, "SetUserPassword('%s'); SetUserDigitalIDPath('%s'); app.execMenuItem('%s');",

					pwd, digitalIDPath, menuItem); 	



	return AFExecuteThisScript (pdDoc, jsScript, NULL);

}



*********************************************************************/




sdkAddsignature.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Add My Signature. 


This JavaScript sample shows you can programmatically sign a PDF document using your digital ID file. 


As a sample, this file has included all the digital signature information except the path and password for 
the digital ID file to be used.  


When you are ready to sign a PDF, click the newly added “Add My Signature” menu item under the  
Edit->Acrobat SDK JavaScript menu. After you input the platform-independent path and the password 
through a dialog, the program will create a digital signature field in the top-left corner, and sign it with 
your data. The path and password are valid in an Acrobat session, so you can continue to sign more 
documents in the session without the input dialogs.  


If you change the code to specify the path and password for the digital ID file to be used in this file, then 
when you click the menu item, the program will automatically sign PDFs without UI.  


Using the function SetUserPassword() and function SetUserDigitalIDPath() in this folder JavaScript code, 
you can call the JavaScript to quietly sign a PDF from other JavaScript code, or from a plug-in or IAC VB 
or VC program through function ExecuteThisScript(). The VB and C sample code is attached at the end of 
this file. A digital signature file (DrTest.pfx) is provided with the sample for your test. To use it, put it in a 
folder, and specify the proper IDpath (for example /C/ DrTest.pfx). Its password is “testpassword”. 
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 AnnotatedWords.js



 - Folder-level Acrobat JavaScript file.



*********************************************************************/



/* 

 * AnnotatedWords.js

 * 

 * This JavaScript adds a menu item under Edit>Acrobat SDK JavaScript menu:

 * Copy Annotated Words. 

 * 

 * This script returns to the console the words covered by highlight 

 * annotations. The script can be adapted to output the text elsewhere,

 * such as to a file. It can also be edited to include other text-related 

 * annotations, such as underline or cross-out.

 * 

 * Annotations are processed one page at a time. Each page's words

 * are stored in the ACROSDK.pageWords array of Word objects. 

 * This is a brute force method; other storage solutions 

 * might be considered.

 * 

 * This script is limited to single-column, left-to-right, top-to-bottom, 

 * horizontal, non-overlapping text. 

 * Vertical text, text bound to a shape, right-to-left text, etc., 

 * will require special handling or may not work at all.

 * 

 * Note that text is recovered annotation by annotation in the order 

 * that the annotations were applied to the doc, not in reading order

 * or any other word order on the page. 

 * 

 * Text returned may not always match exactly the text covered by the highlight.

 * This is mainly dependent upon two things: 1) whether a word is adjacent to 

 * punctuation or not, and 2) whether whole words or partial wordsare highlighted 

 * or not.

 * When a word is followed by a space, getPageNthWordQuads()returns the quads of 

 * only the word's characters, but if the word is adjacent to punctuation,

 * then the quads returned include the punctuation. Thus, an annotation that 

 * includes a word and a space will never have quads that exactly match those 

 * returned by getPageNthWordQuads. This script manages this by providing 

 * a ACROSDK.vertMargin variable to set a range within which a match 

 * might be obtained.  

 * Additionally, depending on line spacing, the vertical boundaries of a annotation

 * may not exactly match those of the word. The ACROSDK.horizMargin variable sets

 * the range within a match is considered.

 */



/*

 * Use of an object to emulate a unique namespace.

 *

 * Object literals act like global variables

 * defined within this particular namespace.

 */

if (typeof ACROSDK == "undefined")

	var ACROSDK = {};

	

// array to store page's words and their quads

ACROSDK.pageWords = []; 



/* 

 * margin in user space units to consider a match for 

 * vertical alignment of words and annotations

 *

 * practice has shown this is pretty close

 * except when highlights are multi-line

 *

 * this can be hard-coded or vary with font size and

 * line spacing of document. 

 */

ACROSDK.vertMargin = .1;



/*

 * margin in user space units to consider a match for

 * start or end of word and annotation

 *

 * practice has shown horizontal can vary more widely, 

 * especially near punctuation and with larger font sizes

 */

ACROSDK.horizMargin = 1;  



if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

	   cName:"ACROSDK:JSSubMenu", 

	   cUser: "Acrobat SDK JavaScript", 

	   cParent: "Edit", 

	   nPos: 0

	});

}



app.addMenuItem( {

   cName:"ACROSDK:CopyAnnotatedWords", 

   cUser:"Copy Annotated Words",

	cParent: "ACROSDK:JSSubMenu", 

	cExec: "annotatedWordsMain();", 

	// active only with docs open

	cEnable: "event.rc = (event.target != null);"

});

		

/**

 * function to define a Word object

 */

function Word(text, wordQuads, quadSets)

{

   this.text = text;

   this.wordQuads = wordQuads;

   this.quadSets = quadSets;

}



/**

 * function to store a documents words

 * as you get them, called for each page

 */

function storePageWords(thisDoc,thisPage)

{

   ACROSDK.pageWords = [];

   

   for (var wd = 0; wd < thisDoc.getPageNumWords(thisPage); wd++)

   {

      ACROSDK.pageWords[wd] = new Word(thisDoc.getPageNthWord(thisPage,wd), thisDoc.getPageNthWordQuads(thisPage,wd), thisDoc.getPageNthWordQuads(thisPage,wd).length);

   }

}



/**

 * function to return words overlapping with annotation Quads

 *

 * In all cases this function searches from 1st word to last word.

 * An update might be considered which sorts the words in some way

 * and performs a more efficient search based on that sort.

 */

function wordsFromQuads(annotPage, annotQuads)

{

   // return value

   var highlightedWords = ""; 

   

   // annotation's boundaries

   var left, right, top, bottom; 

    

   /* 

    * review equivalent array entries to the above "sides" since not 

    * assigning to vars. We use the wordQuads property instead.

    *

    * wordLeft = ACROSDK.pageWords[i].wordQuads[0][0] = ACROSDK.pageWords[i].wordQuads[0][4]

    * wordBottom = ACROSDK.pageWords[i].wordQuads[0][1] = ACROSDK.pageWords[i].wordQuads[0][3]

    * wordRight = ACROSDK.pageWords[i].wordQuads[0][2] = ACROSDK.pageWords[i].wordQuads[0][6]

    * wordTop = ACROSDK.pageWords[i].wordQuads[0][5] = ACROSDK.pageWords[i].wordQuads[0][7]

    */

   

   // index for page's words, start at 1st word

   var iWord = 0; 

   

   /*

    * the following variable assignments assume a rectangular quad over 

    * horizontal text. That is, (annotQuads[0]==annotQuads[4])= left,

    * annotQuads[1] == annotQuads[3] = bottom, etc. 

    * note that array value of quads property consists of points 

    * in this order: [X1 Y1 X2 Y2 X4 Y4 X3 Y3]

    *

    * See PDF Reference "Quadpoints Specification" for more information.

    */

   left = annotQuads[0];

   bottom = annotQuads[1];

   right = annotQuads[2];

   top = annotQuads[5];

   

   /*

    * This assumes left-to-right, top-to-bottom flow of text on page

    *

    * Iterate through words until find a word on same line as annot or run out of words

    * (search vertically for 1st word whose bottom is at or below annotation's bottom)

    *

    * upon exit you have 1st word on same line as current annotation    

    */

   while ( iWord < ACROSDK.pageWords.length-1) 

   { 

      if ( !((ACROSDK.pageWords[iWord].wordQuads[0][1] > top) && (ACROSDK.pageWords[iWord].wordQuads[0][1] < (bottom + ACROSDK.vertMargin))) )

         iWord++; 

      else

         break;

   }



   /*   

    * Find first word on this line that overlaps with annot

    * while on same line and have not run out of words (due to highlight over space or punctuation only)

    * while words are to left of annot (left edge of word and right edge of word < left

    *

    * upon exit you have first word that overlaps annotation    

    */

   while ((ACROSDK.pageWords[iWord].wordQuads[0][0] < left) && (ACROSDK.pageWords[iWord].wordQuads[0][2] < left) && (iWord < ACROSDK.pageWords.length-1) && (Math.abs(bottom - ACROSDK.pageWords[iWord].wordQuads[0][1])< ACROSDK.vertMargin))

   {  iWord++; }



   /*   

    * if the 1st word does not start after the annotation (no words under annot), 

    * then add it to highlighted words and continue adding words 

    */

   if ((ACROSDK.pageWords[iWord].wordQuads[0][0] <= (left + ACROSDK.horizMargin)) && (Math.abs(bottom - ACROSDK.pageWords[iWord].wordQuads[0][1])< ACROSDK.vertMargin) && (iWord < ACROSDK.pageWords.length-1)) 

   {

      highlightedWords = ACROSDK.pageWords[iWord].text + " ";

      iWord++;

   }

 

   /*

    * while annotation and words overlap horizontally, add more words

    * continue to check that not out of words and on same line

    */

   while (((ACROSDK.pageWords[iWord].wordQuads[0][0] < right) || (ACROSDK.pageWords[iWord].wordQuads[0][2] <= right)) && (Math.abs(bottom - ACROSDK.pageWords[iWord].wordQuads[0][1])< ACROSDK.vertMargin) && (iWord < ACROSDK.pageWords.length-1) ) 

   { 

      highlightedWords += ACROSDK.pageWords[iWord].text + " ";

      iWord++;

   }

   

   return highlightedWords;

} 



/*

 * main function

 * 

 * called by menu item

 */

function annotatedWordsMain() 

{



   var myAnnots = new Array();

   var numQuadArrays;

   var quadArray = new Array();

   

   // grab Doc object to pass to functions

   var myDoc = event.target; 

   

   console.println("-----------------------------");

   console.println("Acrobat SDK Annotated Words");

   console.println("Document: " +this.info.Title);

   

   // get document's annotations

   this.syncAnnotScan();

   

   for (var pg = 0; pg < this.numPages; pg++) 

   {

      // get the annots on the page

      myAnnots = this.getAnnots({nPage: pg}); 

      

      if(myAnnots != null) 

      {

         // store words and quads

         storePageWords(myDoc,pg);

      

         // print heading

         console.println(" -- Page " + (pg+1) + " -- ");

      

         // for each annot

         for (var i=0; i<myAnnots.length; i++)   

         {

            /*

             * if it's a highlight

             * can also expand this to include Underline, StrikeOut, etc.

             */

            if (myAnnots[i].type == "Highlight")

            {

               /*

                * Each set of quads is handled as a separate annotation when retrieving

                * words. This code could be improved when many multi-line annotations are

                * expected so that words are not searched from beginning of page each time.

                */

               for(var j=0; j<myAnnots[i].quads.length; j++) 

               {					

                  var results = wordsFromQuads(pg, myAnnots[i].quads[j]);

                  if (results != "") 

                  { 

                     // check to not print blank lines

                     console.println(results);

                  }

               }

            }

         }

      }

   }

   console.show(); //open console to show results

}








sdkAnnotatedWords.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Copy Annotated Words. 


This script returns to the console the words covered by highlight annotations. The script can be adapted to 
output the text elsewhere, such as to a file. It can also be edited to include other text-related annotations, such 
as underline or cross-out.  


Annotations are processed one page at a time. Each page’s words are stored in the pageWords array of Word 
objects. 


This is a brute force method; other storage solutions might be considered. This script is limited to single-
column, left-to-right, top-to-bottom, horizontal, non-overlapping text. Vertical text, text bound to a shape, right-
to-left text, and so on will require special handling or may not work at all.  


Note that text is recovered annotation-by-annotation in the order that the annotations were applied to the 
document, not in reading order or any other word order on the page.  


Text returned may not always match exactly the text covered by the highlight. This is mainly dependent on two 
things: 1) whether a word is adjacent to punctuation or not, and 2) whether whole words or partial words are 
highlighted or not.  


When a word is followed by a space, getPageNthWordQuads() returns the quads of only the word’s 
characters, but if the word is adjacent to punctuation, the quads returned include the punctuation. Thus, an 
annotation that includes a word and a space will never have quads that exactly match those returned by 
getPageNthWordQuads. This script manages this by providing a vertMargin variable to set a range within 
which a match might be obtained.  


Additionally, depending on line spacing, the vertical boundaries of an annotation may not exactly match those 
of the word. The horizMargin variable sets the range within which a match is considered.  
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		Text3: Name






/*********************************************************************



 ADOBE SYSTEMS INCORPORATED

 Copyright 1994-2008 Adobe Systems Incorporated

 All rights reserved.



 NOTICE: Adobe permits you to use, modify, and distribute this file

 in accordance with the terms of the Adobe license agreement

 accompanying it. If you have received this file from a source other

 than Adobe, then your use, modification, or distribution of it

 requires the prior written permission of Adobe.



 ---------------------------------------------------------------------



 sdkAnnotSample.js



 - Javascript code created by Acrobat SDK.



*********************************************************************/



/*

 * sdkAnnotSample.js

 * 

 * Folder level JavaScript code to exercise annotation APIs useful in 

 * reviewing workflow. It can be used with the Rights-Enabled PDF in Reader

 * as well as the regular PDF in Acrobat.

 * 

 * A new menu item is added under the Edit>Acrobat SDK JavaScript menu 

 * by this folder JS file. 

 * It will trigger a jsADM dialog to show the following functions: 

 *    Set annotations  readonly or editable.

 *    Import annotations  from a local FDF file.

 *    Export annotations  to a local FDF file.

 *    Export editable annotations  to a local FDF file.

 *  

 * To run the sample, you need a file for data repository in your environment. 

 * A default file is set for Windows in the code.

 * 

 * Trusted function is used to raise the execution privilege in Acrobat 7.

 */



/*

 * Use of an object to emulate a unique namespace.

 *

 * Object literals act like global variables

 * defined within this particular namespace.

 */

if (typeof ACROSDK == "undefined")

	var ACROSDK = {};

	

/*

 * Hard coded local file path For output FDF file.

 * The local file must have a safe path in the device-independent format, 

 * see AcroJS.pdf for details. The temp directory must exist for fdf

 * to be written to it.

 */

ACROSDK.FDFFile = "/C/temp/annotSample.fdf";



if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

	   cName:"ACROSDK:JSSubMenu", 

	   cUser: "Acrobat SDK JavaScript", 

	   cParent: "Edit", 

	   nPos: 0

	});

}



// add a new menu item under Edit for the sample.

app.addMenuItem( {

	cName: "ACROSDK:AnnotSample", 

	cUser: "Annotation Sample",



	// new menu item under the "Edit" menu.

	cParent: "ACROSDK:JSSubMenu",



	// enabled only if there are open PDFs.

	cEnable: "event.rc = (event.target != null);", 



	// when clicked, call an user method.

	cExec: "if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0) \

				trustedAnnotToolkit(ACROSDK.myAnnotToolkitDialog, event.target);  \

			else annotToolkit(ACROSDK.myAnnotToolkitDialog, event.target);"

} );





// trusted function wrapper for version 7 

if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0)

	trustedSaveAnnotsToFile = app.trustedFunction(saveAnnotsToFile);



/**

 * user method

 */

function saveAnnotsToFile(doc)

{

   try{ 



		doc.syncAnnotScan();



		// for Acrobat 7 to raise the execution privilege of the following code

		if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0)

			app.beginPriv();



		// save annots to file

		doc.exportAsFDF({



         // save to a fdf file with a safe path 

         cPath: ACROSDK.FDFFile,	 

   

         // not exporting form data

         aFields:[],

   

         // export all annotations

         bAnnotations: true

		}); 



		// end of raising the execution privilege

		if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0)

			app.endPriv();

			

	} catch (e) {

		console.println("error saving annots to file : " + e);

	}

}



/**

 * user method

 */

function saveEditableAnnotsToFile(doc)

{

	try{ 

		doc.syncAnnotScan();



		// declare an array to store annot properties 

		var myCopyAnnotsProps = new Array();

		var num = 0;



		// set doc.delay as true so changes won't be shown immedeately

		doc.delay = true;



		// enumerate annot objects to find read only annots.

		for (var j = 0; j < doc.numPages; j++) {

			var annots = doc.getAnnots( {nPage:j} );

			for (var i = 0; i < annots.length; i++)



				// store the properties for the readonly annot then delete the annot. 

				if(annots[i].readOnly == true) 

				{

					myCopyAnnotsProps[num++] = annots[i].getProps();

					annots[i].readOnly == false;

					annots[i].destroy();

				}

		}



		// we only export editable annotations to file 

		if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0) 

		   trustedSaveAnnotsToFile(doc);  

		else 

		   saveAnnotsToFile(doc);	



		// after export, we restore the removed annot objects back. 

		for (var n in myCopyAnnotsProps) 

			doc.addAnnot(myCopyAnnotsProps[n]);

		

		// Ok, now update the display

		doc.delay = false;



	} catch (e) {

		console.println("error saving editable annots to file : " + e);

	}

}



/**

 * user method

 */

function retrieveAnnotsFromFile(doc)

{

	try { 

		// load data from FDF file

		doc.importAnFDF(ACROSDK.FDFFile);		 

	} catch (e) {

		console.println("error retrieving annots from file : " + e);

	}

}



/**

 * user method

 */

function changeAllAnnotsReadOnly(doc, b)

{

	try{ 

		// go through all annot objects and set the readonly property

		doc.syncAnnotScan();

		for (var j = 0; j < doc.numPages; j++) {

			var annots = doc.getAnnots( {nPage:j} );

			for (var i = 0; i < annots.length; i++)

				annots[i].readOnly = b;

		}

	} catch (e) {

		console.println("error changing all annots readOnly property : " + e);

	}

}





// trusted function wraper for version 7 

if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0) 

	trustedAnnotToolkit = app.trustedFunction(annotToolkit);





// function to launch the dialog 

function annotToolkit(dialog, doc)

{	

	dialog.doc = doc;

	if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0) 

		app.beginPriv();

	app.execDialog(dialog);

	if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0) 

		app.endPriv();

}



// dialog object

ACROSDK.myAnnotToolkitDialog =

{

	// initialize

	initialize: function(dialog)

	{

		dialog.load({ "afil": ACROSDK.FDFFile });

	},



	

	// function associated with button 1 to export all annots

	"btn1":function(dialog)

	{

		ACROSDK.FDFFile = dialog.store()["afil"];

		if (typeof app.formsVersion != 'undefined' && app.formsVersion >= 7.0) 

				trustedSaveAnnotsToFile(this.doc);  

		else saveAnnotsToFile(this.doc);

			

		dialog.end();

	},

	

	// function associated with button 2 to export editable annots

	"btn2":function(dialog)

	{

		ACROSDK.FDFFile = dialog.store()["afil"];

		saveEditableAnnotsToFile(this.doc);

		dialog.end();

	},

	

	// function associated with button 3 to import annots

	"btn3":function(dialog)

	{

		ACROSDK.FDFFile = dialog.store()["afil"];

		retrieveAnnotsFromFile(this.doc);

		dialog.end();

	},

	

	// function associated with button 4 to set all annots to be read only 

	"btn4":function(dialog)

	{

		changeAllAnnotsReadOnly(this.doc, true);

		dialog.end();

	},

	

	// function associated with button 5 to set all annots to be editable 

	"btn5":function(dialog)

	{

		changeAllAnnotsReadOnly(this.doc, false);

		dialog.end();

	},

	

	// Dialog Description

	description:

	{

		name: "Annotation Sample",

		elements:

		[

			{

				type: "view",

				align_children: "align_left",

				elements:

				[

					{

						type: "cluster",

						align_children: "align_fill",

						elements:

						[

							{

								type: "button",

								name: "Export All Annotations",

								item_id: "btn1"

							},

							{

								type: "button",

								name: "Export Editable Only",

								item_id: "btn2"

							},

							{

								type: "button",

								name: "Import Annotations",

								item_id: "btn3"

							},

							{

								type: "button",

								name: "Set Annots to Read-Only",

								item_id: "btn4"

							},

							{

								type: "button",

								name: "Set Annots to Editable",

								item_id: "btn5"

							}

						]

					},

					{

						type: "view",

						alignment: "align_fill",

						align_children: "align_left",

						elements:

						[

							{

								type: "static_text",

								item_id: "txt1",

								name: "Data File : ",

								font_id: 3

							},

							{

								type: "edit_text",

								item_id: "afil",

								alignment: "align_fill"

							}

						]

					},

					{

						type: "ok",

						name: "Close"

					}

				]

			}

		]

	}

};




sdkAnnotSample.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Annotation Sample. 


This sample exercises annotation APIs useful in reviewing workflow. It can be used with the Rights-Enabled 
PDF in Reader as well as the regular PDF in Adobe Acrobat. 


It will trigger a jsADM dialog to show the following functions: 


• Set annotations readonly or editable 
• Import annotations from a local PDF file 
• Export annotations to a local PDF file 
• Export editable annotations to a local PDF file 


To run the sample, you need a file for data repository in your environment. 


A default file is set for Windows in the code.  


Trusted function is used to raise the execution privilege. 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 







 


 


 


 


 


 


 






/*********************************************************************



 ADOBE SYSTEMS INCORPORATED

 Copyright 1998-2008 Adobe Systems Incorporated

 All rights reserved.



 NOTICE: Adobe permits you to use, modify, and distribute this file

 in accordance with the terms of the Adobe license agreement

 accompanying it. If you have received this file from a source other

 than Adobe, then your use, modification, or distribution of it

 requires the prior written permission of Adobe.



 ---------------------------------------------------------------------



 DeleteNoCommentPages.js



 - Folder-level Acrobat JavaScript file.



*********************************************************************/





/* 

 * DeleteNoCommentPages.js

 * 

 * This JavaScript adds a menu item to the Acrobat SDK JavaScript menu under the

 * Edit menu. The new "Delete Pages Without Comments" menu item deletes those pages 

 * in the current document that do not have Annotations on them.

 * 

 * This is similar to a Summarize Comments option in Acrobat 6 where only

 * those pages with comments are kept. In Acrobat 7, this option was removed.

 * This JavaScript allows you to simulate the Acrobat 6 option.

 * 

 * This script provides a status message (alert) upon completion.

 * It can be removed for silent operation needs such as batch processing.

 * 

 * The processed document is not saved. 

 */



if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

	   cName:"ACROSDK:JSSubMenu", 

	   cUser: "Acrobat SDK JavaScript", 

	   cParent: "Edit", 

	   nPos: 0

	});

}



app.addMenuItem({

   cName:"ACROSDK:DeletePagesWithoutComments",

   cUser:"Delete Pages without Comments",

   cParent: "ACROSDK:JSSubMenu", 

   cExec: "mainFunction();", 

   cEnable: "event.rc = (event.target != null);" // active only with docs open

});

		

/** 

 * main function

 */

function mainFunction()

{

    try {



	    var pageDeleteCount = 0;

	    var pageKeepCount = 0;



	    this.syncAnnotScan(); 

	

	    // if there are annots in this doc then process pages 

	    if (this.getAnnots() != null) 

	    {  

	    	// for each page -- go backwards so pageNums are constant

	    	for (var p = this.numPages-1; p>=0; p--)    

	    	{ 

	    		var a = this.getAnnots({nPage: p});  

		    	

		    	// get the page's annots -- if no annots, delete it 

		    	if (a == null) 

		    	{ 

		    		this.deletePages({nStart: p, nEnd: p}); 

		    		pageDeleteCount++;  

		    	} 

		    	else // if annot on the page, keep it and count it

		    	{ 

		    		pageKeepCount++; 

		    	}  

		   }  

	      app.alert(this.title + ": " + pageDeleteCount + " page(s) deleted. " + pageKeepCount + " page(s) kept. " ); 

	    }  else { // else there are no annots 

	    	app.alert("No comments in this document. No pages deleted."); 

	    }

    }



   catch (e) 

   {

   console.println("Error during mainFunction : " + e);

   }

}




sdkDeletenoCommentPages.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Delete Pages without Comments. 


Note: This sample does not work in Adobe Reader.  


The new “Delete Pages without Comments” menu item deletes those pages in the current document that 
do not have Annotations in them. 


This is similar to a summarize Comments option in Acrobat 6 where only the pages with comments are 
retained. In Acrobat 7, this option was removed. 


This JavaScript allows you to simulate the Acrobat 6 option. 


This script provides a status message (alert) upon completion. It can be removed for silent operation 
needs such as batch processing.  


The processed document is not saved.   


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 


 







 


 


 


 


 


 


 






/*********************************************************************



 ADOBE SYSTEMS INCORPORATED

 Copyright 1994-2008 Adobe Systems Incorporated

 All rights reserved.



 NOTICE: Adobe permits you to use, modify, and distribute this file

 in accordance with the terms of the Adobe license agreement

 accompanying it. If you have received this file from a source other

 than Adobe, then your use, modification, or distribution of it

 requires the prior written permission of Adobe.



 ---------------------------------------------------------------------



 sdkGoToBookmark.js

 

 - Javascript code created by Adobe Acrobat SDK.



*********************************************************************/





/*

 * sdkGoToBookmark.js

 * 

 * Folder Javascript Created by Adobe Acrobat SDK.

 * 

 * This JavaScript code will add a menu item "Go To Bookmark..." under Edit>Acrobat SDK JavaScript menu. 

 * The menu function looks for a bookmark matching user input in a PDF document. If found, 

 * execute the bookmark action that generally is going to a pageview.

 * 

 * The user input string is the name of a bookmark to look for. 

 * The search is case insensitive. Various format examples:

 *    < Work with the samples_guide.pdf document in SDK >

 *    "SDKJSSnippets" - get the first match in any level

 *    "Guide to SDK Samples:JavaScript Samples:Inside PDF:SDKJSSnippets" -	hierarchy, 

 *             each token in one level down. 

 *    "Guide to SDK Samples:*:SDKJSSnippets" - hierarchy, 

 *              "*" means there may be any number of levels there.

 *             

 * To cancel, press Esc on Wins or command-period on Mac. 

 */



if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

	   cName:"ACROSDK:JSSubMenu", 

	   cUser: "Acrobat SDK JavaScript", 

	   cParent: "Edit", 

	   nPos: 0

	});

}



// Add a menu for GetBookmarkName()

app.addMenuItem( { 

   cName: "ACROSDK:GoToBM", 

   cUser: "Go To Bookmark...", 

   cParent: "ACROSDK:JSSubMenu", 

   cEnable: "event.rc = (event.target != null);",

   cExec: "GetBookmarkName(event.target)" 

});



/**

 * Take the doc object pass to use from the menu, get the bookmark to search for

 * and pass these to GoToBookmark() 

 */

function GetBookmarkName(doc)

{

	var str = util.printf("Enter a Bookmark to find in document %s. \nUse A:B:C:D or A:*:D for hierarchy.", doc.documentFileName);

    resp = app.response({

        cTitle: "Find Bookmark",

        cQuestion: str

    });

    if ( resp != null ) {

		if(GoToBookmark(doc, resp)==null)

			app.alert("The bookmark is not found.");

	}

}





/** 

 * it search for a specific bookmark in a PDF document. If found, 

 * execute the bookmark action that generally is going to a pageview.

 * 

 * input: pdfDoc - Doc object 

 * input: bmNameToFind - string, name of a bookmark to look for. 

 *   The search is case insensitive. Various format examples:

 *    "ASFileClose" - get the first match in any level

 *    "methods:as layer methods:asfile:ASFileClose" -	hierarchy, 

 *             each token in one level down. 

 *    "methods:*:ASFileClose" - hierarchy, 

 *              "*" means there may be any number of levels there. 

 */  

function GoToBookmark(pdfDoc, bmNameToFind)

{

	// split a possible hierarchy bookmark name such A:B:C into tokens

	var tokens = bmNameToFind.split(':');

	

	// use app thermometer

	var therm = app.thermometer

	therm.duration = 10*tokens.length;

	therm.begin();

	therm.text = "Search bookmarks ... \(Cancel key: Esc on Win, command-period on Mac.\)";

	therm.value = 2;



	// search

	var nLevel = 0;

	var bmFound;

	var bmMatch;



	// go through each token to find match

	for(var i=0;i<tokens.length;i++) {



		// the first token can be in any level of bookmarks

		if(i==0) {

			// remove any star tokens in front

			while (tokens[i]=="*") {

				i++;

			}

			

			bmFound = FindBookmarkByName(pdfDoc.bookmarkRoot, tokens[i]);

		}

		// the star token can be in any level under the previous one

		else if (tokens[i]=="*" && i+1<tokens.length) { 

			bmFound = FindBookmarkByName(bmMatch, tokens[++i]);

		}

		// the token other than star must in the level next to the previous token

		else { 

			bmFound = null;

			if(bmMatch.children != null) 

			for(var j=0;j<bmMatch.children.length;j++) {

				if(bmMatch.children[j].name.toLowerCase() == tokens[i].toLowerCase()) {

					bmFound = bmMatch.children[j];

					break;

				}

			}

		}



		// substitution if found

		if(bmFound != null )

			bmMatch = bmFound;

		// not found, end the process, return null.

		else {

			therm.text = " ";

			therm.end();

			return null;

		}



		// set current value of thermometer

		therm.value = 10*(i+1);

	}



	therm.text = " ";

	therm.end();



	// if found, execute its action.

	bmFound.execute();



	// return the bookmark

	return bmFound; 

}		

		 



function FindBookmarkByName(bmHead, bmNameToFind)

{

	// check this bookmark itself

	if(bmHead.name.toLowerCase() == bmNameToFind.toLowerCase())

		return bmHead;



	// check its children

	if(bmHead.children != null) 

		for(var i=0;i<bmHead.children.length;i++) {

			// recurse

			var bmMatch = FindBookmarkByName(bmHead.children[i], bmNameToFind);

			

			// return if found a match

			if(bmMatch != null ) return bmMatch;

			

			// check if the search is canceled.

			if(app.thermometer.cancel) {

				return null;

			}

		}



	// not found 

	return null;

}






sdkGoToBookmark.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Go to Bookmark. 


The menu function looks for a bookmark matching user input in a PDF document. If found, execute the 
bookmark action that generally is going to a page view. 


The user input string is the name of a bookmark to look for. 


The search is case insensitive. Various format examples <Work with the samples_guide.pdf document in 
SDK>. 


• “SDKJSSnippets” – get the first match in any level 
• “Guide to SDK Samples:JavaScript Samples:Inside PDF:SDKJSSnippets” – hierarchy, each 


token in one level down. 
• “Guide to SDK Samples:*:SDKJSSnippets” – hierarchy, “*” means there may be any number of 


levels there. 


 To cancel, press Esc in Windows or command-period in Mac OS. 
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 sdkPresentationMonitor.js



 - Folder Javascript sample created by Acrobat SDK.



*********************************************************************/





/* 

 * sdkPresentationMonitor.js

 * Folder Javascript Created by Acrobat SDK.

 * 

 * This folder level JavaScript sample will create a set of tools to monitor 

 * the progress of a presentation using PDF slides.

 * This JavaScript code will add a menu item "Presentation Monitor..." under 

 * the Edit>Acrobat SDK JavaScript menu. Click it to get a dialog box to enter 

 * a number of minutes you plan to have for the presentation. After that a monitor 

 * shown in the top of slide page will start. When you go through the pages, you can 

 * use the following tools:

 * - a message showing number of pages untouched.

 * - a message showing time left.

 * - a time progress bar.

 * - a set of page icons: 

 *    The page icons with the different colors can indicate which page is current,

 *    and which pages have been navigated. When the mouse enter/exit a page 

 *    icon, the page image will be shown/hidden in the top left corner. Click 

 *    a page icon, you can go to that page.

 * - the check box: check/uncheck to toggle "show" or "hide" the time bar and page icons.

 * - the quit button with  "X": click to quit the monitor tool.

 * 

 * Note: 

 * The display may be slow since a great number of form field are added through JavaScript. 

 * There is a known issue. When the top margin is not enough, this tool set may overlap the 

 * slide contents. Some improvement may be needed in that situation, e.g. to relocate the monitor 

 * tool set, or first to draw a blank field in the top portion of each slide. As a sample, 

 * the code improvement is not provided.

*/



/*

 * Use of an object to emulate a unique namespace.

 *

 * Object literals act like global variables

 * defined within this particular namespace.

 */

if (typeof ACROSDK == "undefined")

	var ACROSDK = {};

	

// the PDF presentation

ACROSDK.targetDoc = null;



// time 

ACROSDK.nTotalMin;

ACROSDK.nIntervalSecond = 1;

ACROSDK.nSpentSec;

ACROSDK.nMaxTotalTimeMin = 120;  

ACROSDK.nMaxOvertimeMin = 10;  

ACROSDK.oTimeStart;



// dimension

ACROSDK.inch = 72;

ACROSDK.barWidth;



// UI 

ACROSDK.aPagesFlag = new Array();

ACROSDK.bHidden;

ACROSDK.bHotButton;



if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

	   cName:"ACROSDK:JSSubMenu", 

	   cUser: "Acrobat SDK JavaScript", 

	   cParent: "Edit", 

	   nPos: 0

	});

}



// Add a menu for ProgressMonitor() 

app.addMenuItem( { 

   cName: "ACROSDK:TimeMonitor", 

   cUser: "Presentation Monitor...", 

   cParent: "ACROSDK:JSSubMenu", 

   cEnable: "event.rc = (event.target != null);",

   cExec: "ProgressMonitor(event.target);" 

});





/**

 * main entry 

 */

function ProgressMonitor(doc)

{

	// if time monitor has already created, do nothing.

	if(doc.getField("timeMonitorFields")) return;



	// ask user to input a time length

	ACROSDK.nTotalMin = app.response({

		cQuestion: "Enter the total minutes \(<120\) you will have for the presentation:",

		cTitle: "Time Monitor",

		cDefault: "1",

		cLabel: "Response:"

	});

	

	if ( ACROSDK.nTotalMin == null){

		return;

	} else if (isNaN(ACROSDK.nTotalMin)) {

		app.alert("Must enter a number.")

		return;

	} else if (ACROSDK.nTotalMin>ACROSDK.nMaxTotalTimeMin) {

		app.alert("Maximum time is 120 minutes.")

		return;

	}



	// initialize global variables

	ACROSDK.nSpentSec = 0;

	ACROSDK.targetDoc = this;

	ACROSDK.bHidden = false;

	ACROSDK.bHotButton = false;



	// initialize page flags

	for(var i=0;i<doc.numPages;i++) 

		ACROSDK.aPagesFlag[i] = false;



   try {

      // set time started

      ACROSDK.oTimeStart = new Date();

   

      // set a timer

      runTimeBar = app.setInterval("TimeGoing()", ACROSDK.nIntervalSecond*1000 );

   

      // set time out for the timer

      stopTimeBar=app.setTimeOut("TimeOutProc(ACROSDK.targetDoc);",(ACROSDK.nTotalMin)*60000+ACROSDK.nMaxOvertimeMin*60000);

   

      // set doc actions to clean up when doc is closed

      doc.setAction("WillSave", "AskAndClean(ACROSDK.targetDoc);");

      doc.setAction("WillClose", "AskAndClean(ACROSDK.targetDoc);");

   } catch (e) {

      console.println("Error in timer set up");	

   }

}



/** 

 * privileged function

 */

trustedBII = app.trustedFunction(

   function( f, nPage )

   {

     app.beginPriv();

     f.buttonImportIcon( this.path, nPage );

     app.endPriv();

   }

);

  

/**

 * function to create time progress bar and page icons 

 */

function CreatebarAndPages(doc, nPage)

{

   try {

      // flag

      ACROSDK.aPagesFlag[nPage] = true;

      

      // get page box

      var aRect = doc.getPageBox("Crop",nPage);

      

      // cancel button ---

      var barHeight = 0.25*ACROSDK.inch;  

      var x1 = aRect[2]-10-barHeight;

      var x2 = x1 + barHeight;

      var y1 = aRect[1]-5;

      var y2 = aRect[1]-5-barHeight;

      var fCancel = doc.addField("newTimerShort.btnCancel."+nPage, "button", nPage, 

                     [x1, y1, x2, y2] )

      fCancel.setAction("MouseUp", "AskAndClean(ACROSDK.targetDoc);");

      fCancel.buttonSetCaption("X");

      fCancel.textColor = ["RGB",1,0,0];;

      fCancel.strokeColor = ["RGB",1,0,0];

      

      /*

       * toggle hide/show button --- 

       * we create the same button in every page, so we can get general control.  

       */

      if (ACROSDK.bHotButton == false) {

         var j;

         for (j=0;j<doc.numPages;j++) {	

            

            var fToggle = doc.addField("newTimerShort.btnToggle", "checkbox", j, 

                           [x1, aRect[1]-10-barHeight, x2, aRect[1]-10-2*barHeight] );

            fToggle.checkThisBox(0,true);

            fToggle.setAction("MouseUp", 'var f = this.getField("timeMonitorFields"); f.hidden = !(this.getField("newTimerShort.btnToggle").isBoxChecked(0)); ');

            fToggle.strokeColor = ["RGB",0,0,1];

         }

         ACROSDK.bHotButton = true;

      }

            

      // time progress bar --- 

      ACROSDK.barWidth = (aRect[2] - aRect[0])*3/4;

      x2 = aRect[2] - 0.5*ACROSDK.inch;

      x1 = x2 - ACROSDK.barWidth;

      y1 = aRect[1] - 6;

      y2 = y1 - barHeight;

      

      px1 = x1;

      px2 = x2;

      py1 = y2 - 6;

      py2 = y2 - 6 - barHeight;

      var pdx = ACROSDK.barWidth/(doc.numPages);

      

      // the static bar as a base

      var fStaticBar = doc.addField("timeMonitorFields.rectBase"+nPage, "button", nPage, 

                     [x1, y1, x2, y2] )

      fStaticBar.borderStyle = border.s;

      fStaticBar.fillColor = ["RGB",1,1,.755];

      fStaticBar.strokeColor = color.black;

      

      // the moving bar to show the time progress

      var fMovingBar = doc.addField("timeMonitorFields.rectMoving."+nPage, "button", nPage, 

                        [x1, y1, x1+2, y2] )

      fMovingBar.borderStyle = border.s;

      fMovingBar.fillColor = color.blue;

      fMovingBar.strokeColor = color.blue;

      

      // time message --- 

      var fTimeMessage = doc.addField("newTimerShort.txtTimeLeft", "text", nPage, 

                     [aRect[0]+10, y1, aRect[0]+1.8*ACROSDK.inch, y2] )

      fTimeMessage.borderStyle = border.u;

      fTimeMessage.textColor = color.blue;

      

      // page message --- 

      var fPageMessage = doc.addField("newTimerShort.txtPagesLeft", "text", nPage, 

                     [aRect[0]+10, y2-4, aRect[0]+1.6*ACROSDK.inch, y2-4-barHeight] )

      fPageMessage.borderStyle = border.u;

      fPageMessage.textColor = ["RGB",0.3,0.6,0.2];

      

      // page image button --- 

      var fPageImage = doc.addField("newTimerShort.btnPageImage."+nPage, "button", 

                     nPage, [aRect[0]+10, py2,aRect[0]+ACROSDK.barWidth/2, py2-ACROSDK.barWidth/3] )

      fPageImage.readonly = true;

      fPageImage.borderStyle = border.i;

      fPageImage.buttonPosition = position.iconOnly;

      fPageImage.hidden = true;

      fPageImage.fillColor = color.gray;

      

      // page rectangles --- 

      var pdWidth = Math.floor(ACROSDK.barWidth/(doc.numPages-1));

      if (pdWidth > barHeight) pdWidth = barHeight;

      

      for (j=1;j<=doc.numPages;j++) {

         var fPageRectangle = doc.addField("timeMonitorFields.rectPages." + j, "button", nPage, 

            [px1+j*pdx-pdWidth, py1, px1+j*pdx, py2] );

         fPageRectangle.textSize = 0; // auto sized

         fPageRectangle.textColor = color.black;

         fPageRectangle.buttonSetCaption(j); 

         fPageRectangle.borderStyle = border.s;

         

         fPageRectangle.fillColor = ["RGB",1,1,.855];

         fPageRectangle.strokeColor = color.black;

         

         // set the button actions ---

         // go to the page image when the mouse clicks.

         var fname = "newTimerShort.btnPageImage." + nPage;

         var jsCode =  'var f = this.getField("' + fname + '").hidden = true; this.pageNum = ' + (j-1);

         fPageRectangle.setAction("MouseUp",jsCode);

      

         // show the page image when the mouse enters

         jsCode = 'var f = this.getField("' + fname + '");' 

                  + 'f.hidden = false; trustedBII( f,' + (j-1) + ');';

         

         fPageRectangle.setAction("MouseEnter",jsCode);

         

         // hide the image when the mouse exits.

         jsCode = 'var f = this.getField("' + fname + '");'

                  + 'f.hidden = true;';

         fPageRectangle.setAction("MouseExit",jsCode);

      }

   } catch (e) {

      console.println("Error in create field, bar, and page icons");	

   }

}





/**

 * function for the timer.

 * it will be executed after every time interval, say 1 second. 

 */

function TimeGoing()

{

   try {

      // get time Elapsed from a Date funtion

      var nSpentSec = Math.floor(MilliSecondsElapsed()/1000);

      

      // create "time monitor" fields in the page if they are not done.

      if (ACROSDK.aPagesFlag[ACROSDK.targetDoc.pageNum] == false) 

            CreatebarAndPages(ACROSDK.targetDoc, ACROSDK.targetDoc.pageNum);

      

      this.getField("timeMonitorFields").hidden = ACROSDK.bHidden;

      

      // update pages icons

      var nLeftPages = 0;

      for (var i=0;i<ACROSDK.targetDoc.numPages;i++) {

         if (ACROSDK.aPagesFlag[i] == false) 

            nLeftPages++;

         else if (i==ACROSDK.targetDoc.pageNum) 

            ACROSDK.targetDoc.getField("timeMonitorFields.rectPages." + (i+1)).fillColor = ["RGB",1,.855,1];

         else 

            ACROSDK.targetDoc.getField("timeMonitorFields.rectPages." + (i+1)).fillColor = ["RGB",.7,1,1];

       }

      

      //  message showing pages left

      var sP = ACROSDK.targetDoc.getField("newTimerShort.txtPagesLeft");

      sP.value = nLeftPages + " page\(s\) left.";

      

      // update time monitor bar

      var sT = ACROSDK.targetDoc.getField("newTimerShort.txtTimeLeft");

      var sB = ACROSDK.targetDoc.getField("timeMonitorFields.rectBase" + ACROSDK.targetDoc.pageNum);

      var sM = ACROSDK.targetDoc.getField("timeMonitorFields.rectMoving." + ACROSDK.targetDoc.pageNum);

      

      var gdelta =  ACROSDK.barWidth/(ACROSDK.nTotalMin*60/ACROSDK.nIntervalSecond);

      var sMrect2 = sM.rect[0]+gdelta*nSpentSec;

      if (sMrect2 < sB.rect[2]) {

         sM.rect = [sM.rect[0],sM.rect[1],sMrect2,sM.rect[3]]; 

      

         var nLeftMin = Math.floor((ACROSDK.nTotalMin*60 - nSpentSec)/60);  

         var nLeftSec = ACROSDK.nTotalMin*60 - nSpentSec - nLeftMin*60;

         if (nLeftSec<10) nLeftSec = "0" + nLeftSec; 

         sT.value = nLeftMin + ":" + nLeftSec + " minute\(s\) left";

      } else {

         sM.rect = [sM.rect[0],sM.rect[1],sB.rect[2],sM.rect[3]]; 

         sM.buttonSetCaption("Time is up !");

         sM.textColor = color.red;

      

         var nOverMin = Math.floor((nSpentSec - ACROSDK.nTotalMin*60)/60);  

         var nOverSec = nSpentSec - ACROSDK.nTotalMin*60 - nOverMin*60;

         if(nOverSec<10) nOverSec = "0" + nOverSec; 

         sT.value = nOverMin + ":" + nOverSec + " overtime";

         sT.textColor = color.red;

      }

      

      ACROSDK.bHidden = !(this.getField("newTimerShort.btnToggle.").isBoxChecked(0));

   } catch (e) {

      console.println("Error in timer execution function");	

   }

}





/**

 * function to get user comfirmation 

 */

function AskAndClean(doc)

{

	// if it's already cleaned, do nothing.

	if(!doc.getField("timeMonitorFields")) return;



	// ask user for confirmation

	var nButton = app.alert({

		cMsg: "Do you want to quit time monitor?",

		cTitle: "Time Monitor",

		nIcon: 2, nType: 2

	});

	

	if ( nButton != 4 ) return;



	// clean  

	try {

		app.clearInterval(runTimeBar);

		app.clearTimeOut(stopTimeBar);

		doc.removeField("timeMonitorFields");

		doc.removeField("newTimerShort");

		ACROSDK.nSpentSec = 0;

	} catch (e) {}

}



/**

 * function for the timer

 */

function TimeOutProc(doc)

{

	try {

		app.clearInterval(runTimeBar);

		app.clearTimeOut(stopTimeBar);

		doc.removeField("timeMonitorFields");

		doc.removeField("newTimerShort");

		ACROSDK.nSpentSec = 0;

	} catch (e) {}

}



/**

 * function for the timer

 */

function MilliSecondsElapsed()

{

	oTimeNow = new Date();

	return (oTimeNow - ACROSDK.oTimeStart);

} 








sdkPresentationMonitor.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Presentation Monitor. 


This JavaScript sample will create a set of tools to monitor the progress of a presentation using PDF slides. 


Select the menu item to get a dialog box to enter a number of minutes you plan to have for the presentation. 
After that, a monitor shown in the top of slide page will start.  


When you go through the pages, you can use the following tools: 


• A message showing the number of pages untouched 
• A message showing time left 
• A time progress bar 
• A set of page icons 


The page icons with the different colors can indicate which page is current, and which pages have 
been navigated. When the mouse enters/exits a page icon, the page image will be shown/hidden in 
the top left corner. Click a page icon to go to that page.  


• The check box: check/uncheck to toggle “show” or “hide” the time bar and page icons 
• The quit button with “X”: click to quit the monitor tool 


Note: 


The display might be slow because a large number of form fields are added through JavaScript. 
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 sdkPresentationNote.js



 - Folder Javascript sample created by Acrobat SDK.



*********************************************************************/





/* 

 * sdkPresentationNote.js

 * Folder JavaScript sample Created by Acrobat SDK.

 * 

 * This JavaScript code will add a menu item "Presentation Note..." under 

 * the "Advanced" menu, and the associated menu function will create a temporary 

 * note on top of the front file to show a schedule note. 

 * After the user has entered a number of minutes before start of the presentation, 

 * the note will display and the time shown in the note will be constantly updated 

 * until the specified time period is end.

 * The user may click the menu item again to remove the note anytime.

 */



/*

 * Use of an object to emulate a unique namespace.

 *

 * Object literals act like global variables

 * defined within this particular namespace.

 */

if (typeof ACROSDK == "undefined")

	var ACROSDK = {};

	

// global variables

ACROSDK.targetDoc;

ACROSDK.timeStart;



ACROSDK.nWaitingMin;

ACROSDK.nRemainingMin;

ACROSDK.nIntervalSec = 0.5;

ACROSDK.nIndex;

ACROSDK.bQuit = true;

	

if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

	   cName:"ACROSDK:JSSubMenu", 

	   cUser: "Acrobat SDK JavaScript", 

	   cParent: "Edit", 

	   nPos: 0

	});

}



// Add a menu for PresentationNote()

app.addMenuItem( { 

   cName: "ACROSDK:PresentationNote", 

	cUser: "Presentation Note...", 

	cParent: "ACROSDK:JSSubMenu", 

   cEnable: "event.rc = (event.target != null);",

   cExec: "PresentationNote(event.target);" });



/**

 * main entry

 */

function PresentationNote(doc)

{

	// check flag to toggle start / quit the presentation note. 

	if(ACROSDK.bQuit == true)

		ACROSDK.bQuit = false;

	else {

		ACROSDK.bQuit = true;

		return 1;

	}

		 

	// ask user to input a waiting time length

	ACROSDK.nWaitingMin = app.response({

		cQuestion: "A temporary note will be created " +

			" on top of the front file to show a schedule note." +

			" You can click the menu item again to remove the note anytime." +

			"\nEnter a number of minutes before start of the presentation:",

		cTitle: "Presentation Note",

		cDefault: "1",

	});

	

	if ( ACROSDK.nWaitingMin == null){

		ACROSDK.bQuit = true;

		return 1;

	} else if (isNaN(ACROSDK.nWaitingMin)) {

		app.alert("Must enter a number.")

		ACROSDK.bQuit = true;

		return 1;

	}



   try {

      // get page box

      ACROSDK.targetDoc = this;

      var aRect = doc.getPageBox("Media",doc.pageNum);

   

      // create a text field

      var nHeight = 230;

      var nAdgeX = 100;

      var nAdgeY = 100;

   

      var x1 = aRect[0]+nAdgeX;

      var x2 = aRect[2]-nAdgeX;

      var y1 = aRect[1]-nAdgeY;

      var y2 = y1-nHeight;

      var ft = doc.addField("newNote", "text", doc.pageNum, [x1,y1,x2,y2]);

   

      ft.fillColor = ["RGB",1,0.855,1];;

      ft.strokeColor = ["RGB",0,0,1];

      ft.borderStyle = border.i;

      ft.textColor = color.blue;

      ft.richText = true; 

      ft.multiline = true; 

      ft.readonly = true; 

   

      // set rich text of the field

      Strline1 = "Presentation\r"; 

      Strline2 = "will start\r"; 

      if (ACROSDK.nWaitingMin>1)

         Strline3 = "in " + ( 1 + Math.floor(ACROSDK.nWaitingMin));

      else

         Strline3 = "in " + 1;

      if (ACROSDK.nRemainingMin<=1) 

         Strline3 = Strline3 + " minute\r";

      else 

         Strline3 = Strline3 + " minutes\r";

      ft.richValue = ComposeRichText(3);

   

      // timer

      ACROSDK.timeStart = new Date();

      ACROSDK.nIndex = 0;

      ACROSDK.bQuit = false;

   

      noteTimer = app.setInterval("UpdateNote()", ACROSDK.nIntervalSec*1000 );

   

      // set time out

      stopNoteTimer = app.setTimeOut("Clean();",ACROSDK.nWaitingMin*60000+30000);

   } catch (e) {

		console.println("Error in PresentationNote.");

   }



	return 0;

}



/**

 * internal function to compose the various rich text

 */

function ComposeRichText(nShow)

{

	try {

      var spans = new Array();

   

      spans[0] = new Object();

      spans[0].textColor = color.blue;

      spans[0].textSize = 40;

      spans[0].alignment = "center";

      spans[0].text = "";

   

      spans[1] = new Object();

      spans[1].textColor = color.blue;

      spans[1].textSize = 40;

      spans[1].alignment = "center";

      spans[1].text = "";

   

      spans[2] = new Object();

      spans[2].textColor = color.red;

      spans[2].textSize = 45;

      spans[2].alignment = "center";

      spans[2].text = "";

   

      if(nShow>0) spans[0].text = Strline1;

      if(nShow>1) spans[1].text = Strline2;

      if(nShow>2) spans[2].text = Strline3;

   } catch (e) {

		console.println("Error in ComposeRichText.");

   }



	return spans;

}





/**

 * internal function executed after every time interval

 */

function UpdateNote()

{

   try {

      // if Quit flag is on, just quit. 

      if (ACROSDK.bQuit == true ) {

         app.clearInterval(noteTimer);

         app.clearTimeOut(stopNoteTimer);

         if (ACROSDK.targetDoc != null) ACROSDK.targetDoc.removeField("newNote");

         return 1;

      }

      

      // get current time

      var timeNow = new Date();

   

      // get the time passed in seconds

      var nSpentSec = Math.floor((timeNow - ACROSDK.timeStart)/1000);

   

      // get the remaining time in minutes

      ACROSDK.nRemainingMin = 1 + Math.floor((ACROSDK.nWaitingMin*60 - nSpentSec)/60);  

   

      // always increase the index

      ACROSDK.nIndex++;

   

      // show various text according to the remaining time and the index.

      var nCycle = 8;

      if (4 <= ACROSDK.nIndex%nCycle && ACROSDK.nIndex%nCycle < 6)  

         ACROSDK.targetDoc.getField("newNote").hidden = false;

   

      else if (0 <= ACROSDK.nIndex%nCycle && ACROSDK.nIndex%nCycle < 4) {

         ACROSDK.targetDoc.getField("newNote").hidden = false;

         if (ACROSDK.nRemainingMin>0) {

            Strline3 = "in " + ACROSDK.nRemainingMin;

            if (ACROSDK.nRemainingMin<=1) 

               Strline3 = Strline3 + " minute\r";

            else 

               Strline3 = Strline3 + " minutes\r";

         }

         else

            Strline3 = "at any moment";

         ACROSDK.targetDoc.getField("newNote").richValue = ComposeRichText(ACROSDK.nIndex%nCycle);

      }

      else 

         ACROSDK.targetDoc.getField("newNote").hidden = true;

   } catch (e) {

		console.println("Error in UpdateNote.");

   }



	return 0;

}





/**

 * internal function to end the timer and remove the note 

 */

function Clean()

{

	try {

		app.clearInterval(noteTimer);

		app.clearTimeOut(stopNoteTimer);

		if (ACROSDK.targetDoc != null) 

		   ACROSDK.targetDoc.removeField("newNote");

		   

		ACROSDK.targetDoc.dirty = false;

		ACROSDK.bQuit = true;

	} catch (e) {

		console.println("Error in Clean.");

	}

}












sdkPresentationNote.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Presentation Note. 


Note: This sample does not work with the Adobe Reader software. 


The associated menu function will create a temporary note on top of the front file to show a schedule note.  


After the user has entered a number of minutes before start of the presentation, the note will display and the 
time shown in the note will be constantly updated until the specified time period ends.  


The user may click the menu item again to remove the note anytime.  
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 SDKSilentPrint.js



 - Folder level Javascript code created by Adobe Acrobat SDK.

 

 *********************************************************************/

 

 

 /*

  * The sample will add "Silent Print" under Acrobat File menu. 

  * Click it to print the front document to the default printer without user interface.

  * It works for Reader, too. 

  * 

  * See Acrobat JavaScript reference and guide SDK documents for further information.

  */



if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

		cName:"ACROSDK:JSSubMenu", 

		cUser: "Acrobat SDK JavaScript", 

		cParent: "Edit",

		nPos: 0

	});

}



/*

 * Add a menu item

 * you can execute this menu item from other programs such as IAC VB / VC code.

 */

app.addMenuItem( { 

	cName: "ACROSDK:SilentPrint", 

	cUser: "Silent Print", 

	cParent: "ACROSDK:JSSubMenu",

   cEnable: "event.rc = (event.target != null);",

   cExec: "JSSilentPrint(event.target)" 

});





/**

 * trustedPrint function: Exercise the print function in the privileged context

 * 

 * @param doc The Doc object of the target document

 * @param pparam The PrintParams object containing print settings

 */

trustedPrint = app.trustedFunction(

	function(doc, pparams) {

		app.beginPriv();

		doc.print(pparams);

		app.endPriv();

	}

);



/**

 * Main function: Print silently

 *

 * @param theDoc The event target of executing the menu item of this sample.

 */

function JSSilentPrint(theDoc)

{

	// get the printParams object of the default printer

	var pp = theDoc.getPrintParams();



	// print all pages.

	// You can print certain pages using code:

	//    pp.firstPage = theDoc.pageNum1;

	//    pp.lastPage = theDoc.pageNum2;



	// silent print,  

	// you can also try .automatic instead of .silent

	pp.interactive = pp.constants.interactionLevel.silent;



	// set flag value which may include many options.

	// here we enable automatic paper tray selection

	var fv = pp.constants.flagValues;

	pp.flags |= fv.setPageSize;



	// Print to the default printer without invoking the print dialog

	trustedPrint(theDoc, pp);

}












sdkSilentPrint.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Silent Print. 


Select the menu item to print the front document to the default printer without user interface.  


The sample works for Reader too. 


See Acrobat JavaScript reference and SDK documents for further reference.   
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 sdkJSTextExtract.js



 - Folder Javascript Created by Acrobat SDK.

 

*********************************************************************/





/*

 * This folder level JavaScript file demonstrates how to extract the text 

 * in PDF page content and save it to a text file.

 *

 * It uses getPageNthWord to get the word one by one from the current page's text content, 

 * then creates a data object and exports it to a file.     

 */



if ( typeof sdkMenuItem == "undefined")

	var sdkMenuItem = false;

	

if (!sdkMenuItem) {

	sdkMenuItem = true;

	app.addSubMenu( { 

		cName:"ACROSDK:JSSubMenu", 

		cUser: "Acrobat SDK JavaScript", 

		cParent: "Edit", 

		nPos: 0

	});

}



// add a menu item  to extract text. 

app.addMenuItem(  {  

	cName: "ACROSDK:ExtractText",   

	cUser: "Extract Text ...",   

	cParent: "ACROSDK:JSSubMenu", 

	cEnable: "event.rc = (event.target != null);",  

	cExec: "ExtractText();"

});  



/**

 *	function to extract the text content of the current page and save to a file.

 */ 

function ExtractText()  

{  

	try  {

		var p = this.pageNum; 

		var n = this.getPageNumWords(p);

		app.alert("Number of words in the page: " + n);



		var str = "";

		for(var i=0;i<n;i++) {

			var wd = this.getPageNthWord(p, i, false);   

			if(wd != "") str = str + wd;   

		}



		// save the string into a data object

		this.createDataObject("dobj1.txt",str);  



		// pop up a file selection box to export the data 

		this.exportDataObject("dobj1.txt"); 

		 

		// clean up

		this.removeDataObject("dobj1.txt"); 



	} catch (e)  {  

		app.alert(e)

	};  

}

 




sdkJSTextExtract.js 


Acrobat SDK Folder-Level JavaScript Sample 


This JavaScript adds a menu item under Edit->Acrobat SDK JavaScript: Extract Text. 


This folder-level JavaScript file demonstrates how to extract the text in PDF page content and save it to a text 
file.  


It uses getPageNthWord to get the word one-by-one from the current page’s text content, then creates a data 
object and exports it to a file.  


 








Call Media ActionScript







		Description: This sample demonstrates the ability to invoke ActionScript methods embedded in the Rich Multimedia Annotation from Acrobat JavaScript.

ActionScript methods to be exposed to the ExternalInterface of the container (Acrobat Flash Framework) register themselves as callable from the container via the ExternalInterface.addCallback method.

Click on the Play/Pause/Reset buttons and observe messages displayed by the ActionScript callback methods invoked by the button actions JavaScript.

		btnPause: 

		btnPlay: 

		btnReset: 








 





		NestTwoLog: []

		NestOneLog: []

		PropOneLog: []

		PropTwoLog: []

		BtnViewSource: 

		BtnClear: 

		TxtTitle:  Event State Demo

		TxtExplain: This sample demonstrates two ways for event listeners to have local persistent state.

The colored boxes at the top of each column below are ScreenAnnots with event listeners that log events to the list boxes below. Click each one to start logging, then move the mouse around among them and click some more to watch the events being logged.

		TxtExplain2: The two ScreenAnnots on the left use local variables and nested scope, and the two on the right use properties in the event listener object. Each technique is useful in different situations. Click the View Source button to see how each is implemented.

For simplicity, this sample uses ScreenAnnots with no actual multimedia playback, only event listeners. The same techniques work with media player event listeners and other JavaScript objects.








 











		BtnPlay: 

		BtnViewSource: 

		TxtDescription: This sample demonstrates the use of JavaScript to cue up two media players and then start them playing simultaneously. When you click the Play button, JavaScript code opens each player with autoPlay turned off and installs an afterReady event listener in each player. When each player has reported afterReady, the code calls their play() methods. This way, the players are all ready to start and begin playing together. You can also click either movie to play it by itself

		TxtDescription2: The video clips are two versions of a Super Bowl animation by Resn8. The animation runs for 20 seconds, but the rough cut is missing the last second of footage, and the finished version runs a second too long. So Acrobat's duration feature is used to play each movie for exactly 20 seconds. This results in a freeze frame at the end of the rough cut.

The finished version on the right features effects added with Adobe After Effects.

		ConvertDates_Heading: Run Media Players








Script Events 







		Description: This PDF demonstrates JavaScript commands sent from a Flash movie. Click on the movie to the right to begin.

In this sample, we simply log the JavaScript commands here (as command: param). You can write custom JavaScript code to interpret movie commands as you wish.

		TxtEventLog: Public domain, courtesy of the Prelinger Archives: www.archive.org/movies

Narrator: Here is Bob Grey of Indianapolis. All set to prove that the hand is quicker than the eye.


		BtnViewSource: 














J. S. Bach


Sheet Music from www.mfiles.co.uk


Two-part Invention, no. 13




           


              


4

             
             





7

            


         
        


10




                         


                 
      


12

             


         
                             
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14

                              



       
         


  


16

                               
       


             


18

                            
                            


20

                                
                 


22

 


                          
                    


24

                             





             

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